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INTRODUCTION

Welcome to EZ Vinyl/Tape Converter — the easiest way to transfer your recordings to your computer. This
software works seamlessly with iTunes®, allowing you to burn your recordings to CD or to transfer them to a
portable digital media device. We hope that you enjoy using this product as much as we enjoyed designing it
for you!

SOFTWARE INSTALLATION - PC

ahwp =

6.
7.
8.

Insert the included CD into your computer's CD drive.

A pop-up screen should appear automatically. Please select your language.

Click on the EZ VINYL/TAPE CONVERTER button to begin the installation process.

Follow the on-screen instructions to install EZ Vinyl/Tape Converter.

Once EZ Vinyl/Tape Converter has been successfully installed, click on the iTunes button to install
iTunes.

Please note: EZ Vinyl/Tape Converter works together with iTunes to convert your recordings to your

computer. iTunes needs to be installed on your computer before starting the EZ Vinyl/Tape Converter
software.

Follow the on-screen instructions to install iTunes.
Once the iTunes installation has successfully completed, click the EXIT button to quit.
EZ Vinyl/Tape Converter and iTunes are now successfully installed on your computer!

SOFTWARE INSTALLATION - MAC
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Insert the included CD into your computer's CD drive.

Open the CD contents and double-click on the EZ Vinyl Tape Converter.Installer.pkg file to begin the
installation process.

Follow the on-screen instructions to install the EZ Vinyl/Tape Converter.
Once the installation process has completed, you can find the EZ Vinyl/Tape Converter application in
your Applications folder.

iTunes is a trademark of Apple, Inc., registered in the U.S.A. and other countries.
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TRANSFERRING MUSIC TO YOUR COMPUTER

Once you have installed the software, you can start recording. Open EZ Vinyl/Tape Converter by going to Start »
All Programs P EZ Vinyl Tape Converter (PC) or your Applications menu (Mac).

STEP 1

Once you start the software, you will see the screen shown on the %
right.

Connect a USB cable from the USB device to an available USB EZ Vinyl/Tape Converter

port on your computer. (This is the only audio connection you need
to make to convert your vinyl or tapes using this software.)

Once the USB device is connected, click Next.

Note: If you are prompted to select your playback device
(Turntable or Tape Player), check the appropriate box and click
Next. If you selected Tape Player, you will be prompted to select
the tape format, Normal or Chrome. (Normal tapes are the most e
common, including store-bought tapes and home recording tapes.)

Note: If you see a message that EZ Vinyl/Tape Converter is unable to initialize your USB device, disconnect all other
USB audio devices (USB speakers, USB audio interfaces, etc.) from your computer, then clicking Next again.

STEP 2

You will see the screen shown on the right.
Locate the beginning of the section you would like to record. We
recommend checking your levels before you begin recording.
If your USB device is equipped with a "gain" control, adjust it
appropriately. You can also adjust the gain slider in the software
next to the volume level meter (the loudest part of the song should A ;
reach the orange part of the meter). o
If you are still dissatisfied with your gain level even after adjusting
the software's gain slider, most computer operating systems
provide a recording input level slider, which you can adjust: s R e .
Windows XP: (not available)
Windows Vista: Click Start Menu » Control Panel (or Settings » Control Panel in Classic View) »
Hardware and Sound » Sound. Click the Recording tab and select "USB Audio Codec" as the default
device. Click Properties. In the new window, click the Levels tab and adjust the Microphone slider
appropriately. We recommend setting the level at "4."
Windows 7: Click Start Menu » Control Panel » Sound. Click the Recording tab and select "USB Audio
Codec" as the default device. Click Properties. In the new window, click the Levels tab and adjust the
Microphone slider appropriately. We recommend setting the level at "4."
Mac: Click the upper-left "apple" icon then click System Preferences » Sound. Click the Input tab and make
sure your USB device is highlighted. From the menu, select your USB recording device and adjust the Input
Volume slider appropriately.
The software will split tracks automatically when it detects silence in the music. For best results, make sure your
volume levels reach the orange part of the software's volume meter during the loudest parts of the song. If your
volume level is too low, EZ Vinyl/Tape Converter may have trouble detecting the difference between sound and
silence. To split the tracks manually, uncheck the box labeled "Automatically split recording into separate tracks" or
"Split recording into tracks." (This is recommended for typical popular music but may produce varied results when
used with other genres like classical music, spoken word, etc.)
When you are ready to start recording, click Record and immediately play your music (press "play," place the needle
over the record, etc.).

STEP 3

You are now recording. You should be hearing the audio from the
device through your computer's speakers and seeing the audio
meters move. If you cannot hear your music, make sure your
computer's volume is not muted. (If still cannot hear your music,
see the Troubleshooting section of this manual.)

If you chose to manually split your recording into tracks, you will
see a "New Track" button. You can use this button to mark the
beginning of a new track.

When you have finished recording, click Next to proceed to the
next step. ok

recording time:  00:00:25

recording track:  Automatic



STEP 4

Once you have finished recording, please enter the Artist, Album

\'/
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and Track titles by clicking and typing into the corresponding S
fields. (If you are recording songs from different artists and
albums, you may need to record them in separate batches.) Tracke [T
Note: If you have recorded more than 10 tracks, you can access Artst
the information for tracks 11-20 by clicking Next. .
When you are finished labeling your recording, click Next. -
»
The software will now export your recording to iTunes. Please -
allow the exporting process to complete. =
STEP 5
Once the software has exported your recordings to iTunes, you will %
see the screen on the right.
Choose Yes if you would like to record again.
Choose No if you do not wish to record more.
When you have made your selection, click Next to record again or
exit the application.
»
STEP 6
You will now be able to access your e EB Von Conrds S advred 1o + o
recordings through your iTunes library. 0% L] ===
Switch over to your iTunes window (iTunes e Tine R - Lol
will open automatically once your tracks 5 Hoves & e si6 Aoz -
have been exported.) Click on the Music | ;.. % nekos mor
library tab on the left and navigate to the | e e e
Artist, Album and Track titles which you | Si™” e i e
entered for your recording. sharep ks Zi s
To view the newest songs added to your H
iTunes library, click the View menu, select | [7="
As List, then right-click (or “ctrl" + click on a Joetiue
Mac) on the Name category above the list of 5 1y Topraed
tracks. In the menu that appears, check S
Date Added and click OK. Above the list of Blnommm
tracks, click the Date Added category. Your 5 ezunoecoerr
newest song will be at the top of the list. o
(You can click the category — Name, Atrtist,
Date Added, etc. — any time you want to re-
order the tracks shown in your iTunes .
L+t 3 =2 @ 10 5000, 27.0 s, 9.6 @

library.)

From iTunes, you can even burn your recordings straight to a CD or load them onto your iPod.

Please consult the iTunes Help menu for more information on using iTunes.

Note that after transferring music to your computer, you may need to reselect your computer's soundcard as
the playback device. Otherwise, you may not hear any sound when playing audio from your computer. For

more information, see the Troubleshooting section.
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TROUBLESHOOTING

PROBLEM

| am not hearing any audio
when | am recording and |
do not see the audio meters
moving.

CAUSE

USB device not powered.

SOLUTION

If your device has a power button, make sure that the USB
device is powered on.

USB device not connected
to the computer.

Make sure the USB device is connected to a working USB
port on your computer. If already connected, try
reconnecting the device and restarting the software.

Bad USB cable or bad USB
port.

Try using a different USB cable. Also, try connecting the
USB device to a different USB port on your computer.

The music is playing and |
see the audio meters
moving but | am not hearing
any audio.

Audio output not set
correctly.

Make sure that your computer's soundcard is selected as
your playback device.

Windows XP: Click Start Menu » Control Panel (or
Settings » Control Panel in Classic View) » Sound and
Audio Devices. Click the Audio tab and under Sound
playback, select your computer's soundcard as the default
device.

Windows Vista: Click Start Menu » Control Panel (or
Settings » Control Panel in Classic View) » Hardware
and Sound » Sound. Click the Playback tab and select
your computer's soundcard as the default device.
Windows 7: Click Start Menu » Control Panel » Sound.
Click the Playback tab and select your computer's
soundcard as the default device.

Mac: Click the upper-left "apple" icon then click System
Preferences » Sound. Click the Output tab. From the
menu, select Internal Speakers if you are using the
computer's internal speakers or select Headphones if you
are using speakers or headphones attached to the
computer's 1/8" headphone output.

Computer speakers are
muted.

Turn up the volume on your computer speakers.

Computer speakers are not
connected.

If using external speakers, make sure that they are
connected to your computer's soundcard.

| am experiencing poor
sound quality.

Cartridge connection is not
secure.

If using a USB turntable, cartridge must be securely
connected to the tonearm whenever you are using the
turntable.

Vinyl record is dirty or
scratched.

If transferring vinyl, try dusting off and gently wiping the
surface of the record before playing it.

Other software applications
are interfering with EZ
Vinyl/Tape Converter.

Close all applications, restart the computer, and only run
EZ Vinyl/Tape Converter while recording.

Stylus may be worn.

Turntables only: If your stylus is over a year old or has
been used extensively, it may be broken or worn. Contact
the ION Audio parts department to purchase another
stylus.

The recording sounds loud
and distorted.

The gain level is too high.

The recording is barely
audible.

The gain level is too low.

If your USB device is equipped with a "gain" control, adjust
it appropriately. You can also adjust the gain slider in the
software next to the volume level meter (the loudest part of
the song should reach the orange part of the meter).

Most computer operating systems provide a recording input
level slider, which you can adjust:

Windows XP: (not available)

Windows Vista: Click Start Menu » Control Panel (or
Settings » Control Panel in Classic View) » Hardware
and Sound » Sound. Click the Recording tab and select
"USB Audio Codec" as the default device. Click
Properties. In the new window, click the Levels tab and
adjust the Microphone slider appropriately. We
recommend setting the level at "4."

Windows 7: Click Start Menu » Control Panel » Sound.
Click the Recording tab and select "USB Audio Codec"
as the default device. Click Properties. In the new window,
click the Levels tab and adjust the Microphone slider
appropriately. We recommend setting the level at "4."

Mac: Click the upper-left "apple" icon then click System
Preferences » Sound. Click the Input tab. From the
menu, select your USB recording device and adjust the
Input Volume slider appropriately.




PROBLEM

| cannot hear my recordings
once | have transferred
them and try to play them on
my computer.

While the USB device is
connected, | cannot listen to
any music from my
computer.

CAUSE

Computer audio output not
set correctly.

skion

SOLUTION

Make sure that your computer's soundcard is selected as
your playback device.

Windows XP: Click Start Menu » Control Panel (or
Settings » Control Panel in Classic View) » Sound and
Audio Devices. Click the Audio tab and under Sound
playback, select your computer's soundcard as the default
device.

Windows Vista: Click Start Menu » Control Panel (or
Settings » Control Panel in Classic View) » Hardware
and Sound » Sound. Click the Playback tab and select
your computer's soundcard as the default device.
Windows 7: Click Start Menu » Control Panel » Sound.
Click the Playback tab and select your computer's
soundcard as the default device.

Mac: Click the upper-left "apple" icon then click System
Preferences » Sound. Click the Output tab. From the
menu, select Internal Speakers if you are using the
computer's internal speakers, select Line Output if you are
using speakers, or select Headphones if you are using
headphones attached to the 1/8" output.

On Windows Vista and
Windows 7, my recordings
are mono instead of stereo.

Recording input properties
not set to "stereo”.

You may need to manually specify "stereo" for the
recording input.

Go to Start P Control Panel » Sound (in Classic View).
Then, click on the Recording tab and highlight the
Microphone input (USB Audio Codec). Click on
Properties to bring up the input settings. Next, click on the
Advanced tab and select "2 channel. 16 bit, 44100 Hz (CD
quality)" in the Default Format pull-down menu. Lastly,
click Apply to accept the settings.

On my Mac, after recording
a file, it appears as "EZACT
Temp" in iTunes and does
not play.

iTunes settings need to be
adjusted.

In iTunes, click the iTunes menu in the upper-left and click
Preferences. Click the General tab then the Import
Settings button and set Import Using to MP3 Encoder.
Then click the Playback tab and uncheck Sound Check,
Sound Enhancer, and Crossfade Songs. Close the
window when finished.

The sound from my USB
device's audio outputs is
distorted or full of static.

Line/phono-level switch may
not be set properly.

Turntables only: If your USB device has a line/phono
switch on its rear panel, make sure it is set to the
appropriate level for the inputs to which it is connected
("line" or "phono"). If your USB device does not have this
switch, please see the Quickstart Guide that came with the
product to determine whether it is line- or phono-level.
Note: You do not need to connect your USB device to a
speaker system, receiver, etc. for EZ Vinyl/Tape Converter
to convert your music. You only need to connect it to your
computer (using a USB cable).

FAQs (FREQUEN SKED QUESTIONS)

Question: What operating systems is EZ Vinyl/Tape Converter compatible with?

Answer: EZ Vinyl/Tape Converter is currently compatible with Windows XP, Vista, and 7 operating systems (32-bit or 64-
bit, as well as with the Mac OS X 10.4.11 operating system (or higher).

Question: What digital format are my recordings converted to?

Answer: The recordings are converted into MP3 files at whatever bitrate is selected in your iTunes Import Settings. To
view/change these settings, in iTunes, click the Edit menu, select Preferences, select the General tab,
and click the Import Settings button. Click the Import Using drop-down menu and select MP3 Encoder. You will
now be able to select the desired bitrate from the Setting drop-down menu below that.

Question: Where are my recordings stored on my computer?

Answer: Your recordings will be stored in the iTunes Music folder. By default, this folder is located in My Documents »
My Music » iTunes P> iTunes Music on Windows OS, or in Music P> iTunes P> iTunes Music on Mac OS and
the contents are organized by Artist name.

Question:  How do | burn my recordings onto a CD?

Answer: There are several different ways to burn your recording onto a CD. You can either use iTunes or another CD-
burning application. To burn a CD using iTunes, create a new Playlist, then drag the songs from your normal
Library onto this Playlist. When you have added all the desired tracks, click on that Playlist, then click the Burn
Disc button. Please consult the Help menu of iTunes (or your alternative application) for more information.

Question: Can | listen to the music through my computer while recording?

Answer: Yes, EZ Vinyl/Tape Converter will automatically monitor incoming audio through your computer as your music is

being transferred. If you are using multiple audio devices, we recommend that you disable any devices which you
do not wish to use for monitoring. For most users, however, this will not be an issue.

7
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INTRODUCCION

Bienvenido a EZ Vinyl/Tape Converter—la forma mas sencilla de transferir sus grabaciones a la
computadora. Este software funciona fluidamente con iTunes®, permitiéndole quemar sus grabaciones en
un CD o transferirlas a un dispositivo de medios digitales. jEsperamos que disfrute al usar este producto
tanto como nosotros disfrutamos disefiandolo para usted!

r 3

INSTALACION DEL SOFTWARE - PC

1. Inserte el CD incluido en el lector de CD de la computadora.

2. Debe aparecer automaticamente una pantalla emergente. Seleccione su lengua.

3.  Haga clic en el botén EZ VINYL/TAPE CONVERTER para comenzar el proceso de instalacion.

4.  Siga las instrucciones de la pantalla para instalar EZ Vinyl/Tape Converter.

5. Una vez instalado exitosamente EZ Vinyl/Tape Converter, haga clic en el botén iTUNES para instalar
iTunes.
Para tener en cuenta: EZ Vinyl/Tape Converter funciona junto con iTunes para convertir sus
grabaciones a su computadora. Es necesario instalar iTunes en su computadora antes de iniciar el
software EZ Vinyl/Tape Converter.

6.  Siga las instrucciones de la pantalla para instalar iTunes.

7. Una vez finalizada exitosamente la instalacién de iTunes, haga clic en el botén EXIT (Salir) para salir.

8. iEZ Vinyl/Tape Converter e iTunes se han instalado exitosamente en la computadoral!

INSTALACION DEL SOFTWARE - MAC

1. Inserte el CD incluido en el lector de CD de la computadora.

2. Abra el contenido del CD y haga doble clic en el archivo EZ Vinyl Tape Converter.Installer.pkg para
comenzar el proceso de instalacion.

3.  Siga las instrucciones de la pantalla para instalar EZ Vinyl/Tape Converter.

4. Una vez terminado el proceso de instalacion, puede encontrar la aplicacion EZ Vinyl/Tape Converter

en su carpeta Applications.



COMO TRANSFERIR MUSICA A COMPUTADORA

Una vez instalado el software, puede comenzar a grabar. Abra EZ Vinyl/Tape Converter yendo a Start P All Programs » EZ
Vinyl Tape Converter (Inicio » Todos los programas P EZ Vinyl Tape Converter) o al menu Applications.

PASO 1

Una vez que inicie el software, vera la pantalla que se ilustra a la derecha.

Conecte un cable USB desde el dispositivo USB a un puerto USB

disponible de la computadora. (Esta es la Unica conexién de audio que EZ Vinyl/Tape Converter

usted necesita para convertir sus vinilos o cintas usando este software.)

Una vez conectado el dispositivo USB, haga clic en Next (Siguiente).

Nota: Si se le indica que seleccione el dispositivo de reproduccion

(Turntable [Giradiscos] o Tape Player [Casetera]), marque la casilla

apropiada y haga clic en Next (Siguiente). Si seleccioné Tape Player, se

le indicard que seleccione el formato de casete Normal o Chrome w
(Cromo). (Los casetes normales son los mas comunes, tales como los que next
se compran en las tiendas o los que se usan para grabaciones caseras.)

Nota: Si ve un mensaje que indica que EZ Vinyl/Tape Converter no puede inicializar su dispositivo USB, desconecte todos los
demas dispositivos USB (altavoces USB, interfaces de audio USB, etc.) de su computadora y haga clic en Next (Siguiente)
nuevamente.

PASO 2

Vera la pantalla ilustrada a la derecha.
Localice el comienzo de la seccion que desea grabar. Recomendamos
verificar los niveles antes de comenzar a grabar.
Si su dispositivo USB esta equipado con un control de "ganancia”, ajustelo e
apropiadamente. También puede ajustar el cursor de ganancia del
software que estd junto al medidor de nivel de volumen (la parte de mayor
volumen del tema debe alcanzar la parte anaranjada del medidor). =
Si aln esta insatisfecho con su nivel de ganancia incluso después de
ajustar el cursor de ganancia del software, la mayoria de los sistemas
operativos de computadora proporcionan un cursor de nivel de entrada de
grabacién que usted puede ajustar:
Windows XP: (no disponible)
Windows Vista: Haga clic en el menu Start » Control Panel (Inicio > Panel de control) (o Settings » Control Panel
(Configuracién > Panel de control) en la vista clasica) » Hardware and Sound » Sound (Hardware y sonido > Sonido).
Haga clic en la pestafia Recording (Grabacion) y seleccione "USB Audio Codec" (Cédec de audio USB) como dispositivo
predeterminado. Haga clic en Properties (Propiedades). En la nueva ventana, haga clic en la pestafia Levels (Niveles) y
ajuste apropiadamente el cursor Microphone (Micréfono). Recomendamos ajustar el nivel a "4".
Windows 7: Haga clic en el menu Start » Control Panel » Sound (Inicio > Panel de control > Sonido). Haga clic en la
pestaina Recording (Grabacion) y seleccione "USB Audio Codec" (Cédec de audio USB) como dispositivo
predeterminado. Haga clic en Properties (Propiedades). En la nueva ventana, haga clic en la pestafia Levels (Niveles) y
ajuste apropiadamente el cursor Microphone (Micréfono). Recomendamos ajustar el nivel a "4".
Mac: Haga clic en el icono superior izquierdo de la "manzana" y luego en System Preferences » Sound (Preferencias del
sistema > Sonido). Haga clic en la pestafa Input (Entrada) y asegurese de que su dispositivo USB esté resaltado. En el
mend, seleccione su dispositivo de grabacién USB y ajuste apropiadamente el cursor Input Volume (Volumen de entrada).
El software divide automaticamente las pistas cuando detecta silencio en la musica. Para obtener los mejores resultados,
aseglrese de que sus niveles de volumen alcancen la parte anaranjada del medidor de volumen del software durante las
partes de mayor volumen del tema. Si su nivel de volumen es demasiado bajo, EZ Vinyl/Tape Converter puede tener
dificultades para detectar la diferencia entre sonido y silencio. Para dividir las pistas manualmente, deseleccione la casilla
rotulada “Automatically split recording into separate tracks” (Dividir automaticamente la grabacion en pistas separadas) o "Split
recording into tracks" (Dividir la grabacién en pistas). (Esto se recomienda para musica popular tipica pero puede producir
resultados variados cuando se usa con otros géneros como musica clésica, palabra hablada, etc.)
Cuando esté listo para comenzar a grabar, haga clic en Record (Grabar) y reproduzca inmediatamente su musica (pulse
"reproducir”, coloque la pua sobre el disco, etc.).
Cuando esté listo a comenzar la grabacion, haga clic en Record (Grabar) y reproduzca inmediatamente la musica.

bac ecord

PASO 3

De esta forma, ya esta grabando. Debe escuchar el audio del dispositivo x
por los altavoces de la computadora y ver que se mueven los instrumentos
medidores de audio.

Si elige dividir manualmente la grabacion en pistas, vera un botén "New
Track" (Nueva pista). Puede usarlo para demarcar el comienzo de una
nueva pista.

Cuando termine de grabar, haga clic en Next para continuar con el paso
siguiente.

recording time: 000025

recording track:  Automatic

»
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PASO 4

Una vez que haya terminado de grabar, introduzca los titulos
Artist, (Artista) Album (Album) y Track (Pista) haciendo clic y
escribiendo en los campos correspondientes.

Para tener en cuenta: Sigrabé mds de 10 pistas, puede acceder
a la informacion de las pistas 11 a 20 haciendo clic en Next.

Cuando termine de rotular su grabacién, haga clic en Next.

El software exportard ahora su grabacién a iTunes. Espere que

termine el proceso de exportacion.

PASO 5

Una vez que el software haya exportado sus grabaciones a

iTunes, vera la pantalla que se ilustra a la derecha.
Elija Yes (Si) si desea grabar nuevamente.
Elija No si no desea grabar mas.

Una vez que haya hecho su seleccién, haga clic en Next para

grabar nuevamente o salga de la aplicacion.

PASO 6

Puede acceder ahora a sus grabaciones a través
de la biblioteca de iTunes. Cambie a la ventana de
iTunes (iTunes se abre automaticamente una vez
que se hayan exportado sus pistas.) Haga clic en
la pestafa de la biblioteca Music (Musica) de la
izquierda y navegue a los titulos de Artist (Artista),
Album (Album) y Track (Pista) que introdujo para
su grabacion.

Para ver los temas agregados mas recientemente

Track:

Artist

Album:

Track title:

»

»

Fie E3t View Contios Stare Advanced Heb

+ em—

Tunes

LiBraR

i o
01y Shows
1 Rodo
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e
SHARED
e

PLAYLISTS

a su biblioteca de iTunes, haga clic en el menl | & e
View (Vista), seleccione As List (Como en la lista), | &
luego haga clic derecho (o "ctrl" + clic en una Mac) Froie

en la categoria Name (Nombre) que esta arriba de
la lista de pistas. En el menu que aparece, marque
Date Added (Fecha del agregado) y haga clic en
OK (Aceptar). Arriba de la lista de pistas, haga clic
en la categoria Date Added. Su tema mas reciente
aparece al tope de la lista. (Puede hacer clic en la

2 Top 25 ost Played
3 E2 oy fTpe Comverter
9 E2VeyTapo Convarter
3 Tradks

+ 2 2 &
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Abm 7
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Abum s
Abum 10

]

categoria —Name, Artist, Date Added, etc.— toda vez que desee reordenar las pistas que se muestran en su

biblioteca de iTunes.)

Desde iTunes, puede incluso quemar sus grabaciones directamente en un CD o cargarlas en su iPod.
Para mas informacion sobre el uso de iTunes, consulte el menu Help (Ayuda) de dicha aplicacion.

Tenga en cuenta que después de transferir la musica a su computadora, es posible que necesite volver a
seleccionar la tarjeta de sonido de la computadora como dispositivo de reproduccion. De lo contrario, es
posible que no oiga ningun sonido cuando reproduzca el audio desde la computadora. Para mas
informacion, consulte la seccién Solucion de problemas.
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SOLUCIO
PROBLEMA

No escucho ningtin
audio cuando grabo y
tampoco veo que se
muevan los medidores
de audio.

DE PROBLEMA

CAUSA

El dispositivo USB no esta
encendido.

SOLUCION

Si su dispositivo cuenta con un botén de encendido, asegurese de que el
dispositivo USB esté encendido.

El dispositivo USB no esta
conectado a la computadora.

Asegurese de que el dispositivo USB esté conectado a un puerto USB en
funcionamiento de la computadora. Siya esta conectado, pruebe desenchufando y
enchufando el dispositivo USB y reiniciando el software.

Cable o puerto USB
defectuosos.

Pruebe usando un cable USB diferente. Trate también de conectar el dispositivo
USB a un puerto USB diferente de la computadora.

La musica se
reproduce y veo que se
mueven los medidores
de audio, pero no
escucho el sonido.

Salida de audio configurada
incorrectamente.

Asegurese de que la tarjeta de sonido de la computadora esté seleccionada como
dispositivos de reproduccion.

Windows XP: Haga clic en el menu Start » Control Panel (Inicio > Panel de
control ) (o Settings » Control Panel (Configuracién > Panel de control) en la vista
clasica) » Sound and Audio Devices (Dispositivos de sonido y audio). Haga clic
en la pestana Audio y bajo Sound playback (Reproduccion de sonido), seleccione
la tarjeta de sonido de su computadora como dispositivo predeterminado.

Windows Vi Haga clic en el menu Start » Control Panel (Inicio > Panel de
control) (o Settings » Control Panel (Configuracién > Panel de control ) en la vista
clasica) » Hardware and Sound » Sound (Hardware y sonido > Sonido). Haga
clic en la pestaia Playback (Reproduccion y seleccione la tarjeta de sonido de su
computadora como dispositivo predeterminado.

Windows 7: Haga clic en el menu Start » Control Panel » Sound (Inicio > Panel
de control > Sonido). Haga clic en la pestaia Playback (Reproduccién) y
seleccione la tarjeta de sonido de su computadora como dispositivo
predeterminado.

Mac: Haga clic en el icono superior izquierdo de la "manzana" y luego en System
Preferences » Sound (Preferencias del sistema > Sonido). Haga clic en la
pestana Output (Salida). En el mend, seleccione Internal Speakers (Altavoces
internos) si va a usar los altavoces internos de la computadora o Headphones
(Auriculares) si va a usar altavoces o auriculares conectados a la salida para
auriculares de 1/8" de la computadora.

Los altavoces de la

computadora estéan silenciados.

Active el volumen de los altavoces de la computadora.

Los altavoces de la
computadora no estan
conectados.

Si usa altavoces externos, asegurese de que estén conectados a la tarjeta de
sonido de la computadora.

Experimento un sonido
de baja calidad.

La conexién de la céapsula no
es firme.

Si usa un giradiscos USB, la capsula debe estar conectada firmemente al brazo de
tono toda vez que lo use.

El disco de vinilo esta sucio o
rayado.

Si esté transfiriendo grabaciones de vinilo, pruebe desempolvando y limpiando
suavemente la superficie del disco antes de reproducirlo.

Otras aplicaciones de software
estan interfiriendo con EZ
Vinyl/Tape Converter.

Cierre todas las aplicaciones, reinicie la computadora y ejecute solamente EZ Vinyl
[Tape Converter.

Su puia puede haberse roto o
desgastado.

Giradiscos tinicamente: Si su pua tiene mas de un afo de antigiiedad o se ha
usado intensamente, puede haberse roto o desgastado. Contacte al departamento
de repuestos de ION Audio para adquirir otra pua.

La grabacion suena
con alto volumen y
distorsionada.

El control de ganancia esta
demasiado alto.

La grabacién apenas
se oye.

El nivel de ganancia es
demasiado bajo.

Si su dispositivo USB estd equipado con un control de "ganancia’, ajlistelo
apropiadamente. También puede ajustar el cursor de ganancia del software que
esté junto al medidor de nivel de volumen (la parte de mayor volumen del tema
debe alcanzar la parte anaranjada del medidor).

Si aun esta insatisfecho con su nivel de ganancia incluso después de ajustar el
cursor de ganancia del software, la mayoria de los sistemas operativos de
computadora proporcionan un cursor de nivel de entrada de grabacion que usted
puede ajustar:

Windows XP: (no disponible)

Windows Vista: Haga clic en el mend Start » Control Panel (Inicio > Panel de
control) (o Settings » Control Panel (Configuracién > Panel de control) en la vista
clasica) » Hardware and Sound » Sound (Hardware y sonido > Sonido). Haga
clic en la pestana Recording (Grabacién) y seleccione "USB Audio Codec"
(Cddec de audio USB) como dispositivo predeterminado. Haga clic en Properties
(Propiedades). En la nueva ventana, haga clic en la pestaiia Levels (Niveles) y
ajuste apropiadamente el cursor Microphone (Micréfono). Recomendamos ajustar
el nivel a "4".

Windows 7: Haga clic en el menu Start » Control Panel » Sound (Inicio > Panel
de control > Sonido). Haga clic en la pestafia Recording (Grabacion) y seleccione
"USB Audio Codec" (Cédec de audio USB) como dispositivo predeterminado.
Haga clic en Properties (Propiedades). En la nueva ventana, haga clic en la
pestana Levels (Niveles) y ajuste apropiadamente el cursor Microphone
(Micréfono). Recomendamos ajustar el nivel a "4".

Mac: Haga clic en el icono superior izquierdo de la "manzana" y luego en System
Preferences » Sound (Preferencias del sistema > Sonido). Haga clic en la
pestana Input (Entrada) y aseglrese de que su dispositivo USB esté resaltado. En
el menu, seleccione su dispositivo de grabacién USB y ajuste apropiadamente el
cursor Input Volume (Volumen de entrada).
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ROBLEMA | CA

o Asegurese de que la tarjeta de sonido de la computadora esté seleccionada como
No puedo oir mis dispositivos de reproduccion.
grabaciones una vez que Windows XP: Haga clic en el mend Start » Control Panel (Inicio > Panel de
la lransie_rl € intenté control ) (o Settings » Control Panel (Configuracién > Panel de control) en la vista
reproducirlas en mi clasica) » Sound and Audio Devices (Dispositivos de sonido y audio). Haga clic
computadora. en la pestafia Audio y bajo Sound playback (Reproduccién de sonido), seleccione
la tarjeta de sonido de su computadora como dispositivo predeterminado.
Windows Vi laga clic en el menu Start » Control Panel (Inicio > Panel de
control) (o Settings » Control Panel (Configuracion > Panel de control ) en la vista
clasica) » Hardware and Sound » Sound (Hardware y sonido > Sonido). Haga
clic en la pestana Playback (Reproduccion y seleccione la tarjeta de sonido de su
: : » 5 computadora como dispositivo predeterminado.
Mientras el dispositivo ETIEEETENE, Windows 7: Haga clic en el menii Start » Control Panel » Sound (Inicio > Panel
USB esta conectado, no de control > Sonido). Haga clic en la pestafia Playback (Reproduccion) y
puedo escuchar ninguna seleccione la tarjeta de sonido de su computadora como dispositivo
misica desde mi predeterminado.
GO ELE, Mac: Haga clic en el icono superior izquierdo de la "manzana” y luego en System
Preferences » Sound (Preferencias del sistema > Sonido). Haga clic en la
pestaia Output (Salida). En el mend, seleccione Internal Speakers (Altavoces
internos) si va a usar los altavoces internos de la computadora o Headphones
(Auriculares) si va a usar altavoces o auriculares conectados a la salida para
auriculares de 1/8" de la computadora.
Es posible que sea necesario especificar manualmente "stereo" para la entrada de
grabacion.
Vaya a Start » Control Panel P Sound (Inicio P Panel de Control » Sonido)
En Windows Vista o Propiedades de entrada de en la vista clasica). Luego, haga clic en la pestafia Recording (Grabacion) y resalte
Windows 7, mis grabacion no configuradas a la entrada Microphone (USB Audio Codec). Haga clic en Properties (Propiedades)
grabaciones son mono en "stereo" (estéreo) para activar la configuracién de la entrada. Luego, haga clic en la pestafia
lugar de estéreo. . Advanced (Avanzadas) y seleccione "2 channel, 16 bit, 44100 Hz (CD quality)" (2
canales, 16 bits, 44100 Hz (calidad de CD)) en el menu desplegable Default Format
(Formato por defecto). Finalmente, haga clic en Apply (Aplicar) para aceptar los
valores de configuracion.

Salida de audio de la
computadora configurada

En iTunes, haga clic en el menu iTunes de la parte superior izquierda y luego en

En mi Mac, después de Preferences (Preferencias). Haga clic en la pestafia General y luego en el botén

grabar un archivo, Import Settings (Importar pardmetros) y ajuste Import Using (Importar usando)

aparece como "EZACT como MP3 Encoder (Codificador MP3). Luego, haga clic en la pestafia Playback

Temp" en iTunes y no se (Reproduccion) y deseleccione Sound Check (Verificacién de sonido) Sound
(Mej

Es necesario ajustar los
parametros de iTunes.

reproduce. il or de sonido) y Ci Songs (Crossfader de temas).
Cierre la ventana cuando termine.
Giradiscos unicamente: Si su dispositivo USB cuenta con un conmutador de nivel
de linea/fonogréfico en su panel trasero, asegurese de que esté colocado en el

. . . nivel apropiado para las entradas a las que esta conectado ("de linea" o

El sonido de las salidas El conmutador de nivel de "fonograficas"). Si su dispositivo USB no tiene este conmutador, consulte la Guia

de audio de mi dispositivo linea/fonografico puede no de inicio rapido provista con el producto para determinar si es de nivel de linea o

USB esta distorsionado o estar colocado fonografico.

lleno de estatica. correctamente.

Nota: No es necesario que conecte su dispositivo USB a un sistema de altavoces,
receptor, etc. para que EZ Vinyl/Tape Converter convierta su musica. Sélo es
necesario que lo conecte a su computadora (mediante un cable USB).

REG S FRECUENTES

Pregunta: ;,Con qué sistemas operativos es compatible EZ Vinyl/Tape Converter?
Respuesta: Actualmente, EZ Vinyl/Tape Converter es compatible con los sistemas operativos Windows XP, Vistay 7 (de 32 ¢
64 bits), como también con el sistema operativos Mac OS X 10.4.11 (o superior).

Pregunta: ;A qué formato digital se convierten mis grabaciones?

Respuesta: Las grabaciones se convierten en archivos MP3 a la velocidad de bits que esté seleccionada en Import Settings
(Configuracion de importacion) de su iTunes. Para ver o cambiar esta configuracion, en iTunes, haga clic en el meni Edit
(Editar), seleccione Preferences (Preferencias), seleccione la pestaiia General y haga clic en el botén Import Settings. Haga
clic en el menu desplegable Import Using (Importar usando) y seleccione MP3 Encoder (Codificador MP3). De esta forma
podra seleccionar la velocidad de bits deseada en el menu desplegable Setting (Ajustes) que esta debajo del mismo.

Pregunta: ;Dénde se almacenan mis grabaciones en la computadora?

Respuesta: Sus grabaciones se almacenan en la carpeta iTunes Music (Musica de iTunes). Por defecto, esta carpeta se
encuentra en My Documents » My Music » iTunes » iTunes Music (Mis documentos » Mi musica » iTunes » Musica de
iTunes) en el sistema operativo Windows o en Music » iTunes » iTunes Music en el sistema operativo Mac, y el contenido
se organiza por nombre de artista.

Pregunta: ;,Cémo quemo mis grabaciones en un CD?

Respuesta: Hay varias maneras diferentes de quemar su grabacion en un CD. Puede usar ya sea iTunes u otra aplicacion de
grabacién de CD. Para quemar CD usando iTunes, cree una nueva Playlist (Lista de reproduccion) y luego arrastre los temas
de su biblioteca normal a esta lista de reproduccién. Cuando haya agregado todas las pistas deseadas, haga clic en esa lista
de reproduccion y luego en el botén Burn Disc (Quemar disco).Para mas informacion consulte el menu Help (Ayuda) de
iTunes o su aplicacién de alternativa.

Pregunta: ;Puedo escuchar mi musica por la computadora mientras grabo?

Respuesta: Si, EZ Vinyl/Tape Converter monitorea automaticamente el audio entrante a través de la computadora a medida
que se transfiere su musica. Si estd usando varios dispositivos de audio, recomendamos que desactive los que no desea usar
para el monitoreo. Para la mayoria de los usuarios, sin embargo, éste no es un problema.
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INTRODUCTION

Voici le EZ Vinyl/Tape Converter — la fagon la plus facile et rapide de transférer vos enregistrements a votre
ordinateur. Ces logiciels fonctionnent de pair avec iTunes®, vous permettant de graver vos enregistrements
sur CD ou de les transférer sur un appareil numérique portable. Nous espérons sincerement que ce produit
vous procure autant d'amusement que nous avons eu a le créer pour vous.

INSTALLATION LOGICIEL PC

I

© N

Insérez le CD d'installation fourni dans le lecteur CD de votre ordinateur.

Une fenétre contextuelle devrait s'ouvrir automatiquement. Sélectionnez votre langue.

Cliquez sur la touche EZ VINYL/TAPE CONVERTER afin de lancer le processus d'installation.

Suivez ensuite les instructions a I'écran pour faire l'installation du EZ Vinyl/Tape Converter.

Une fois le EZ Vinyl/Tape Converter installé correctement, cliquez sur la touche iTunes afin d'installer
iTunes.

Veuillez noter : Le EZ Vinyl/Tape Converter utilise iTunes afin d'importer vos enregistrements et doit
étre installé sur votre ordinateur avant de lancer le EZ Vinyl/Tape Converter.

Suivez ensuite les consignes a I'écran pour faire l'installation de iTunes.

Une fois iTunes installé correctement, cliquez sur la touche QUITTER afin de quitter.

Les applications EZ Vinyl/Tape Converter et iTunes sont maintenant correctement installées sur votre
ordinateur.

INSTALLATION LOGICIEL MAC

1.
2.

Insérez le CD d'installation fourni dans le lecteur CD de votre ordinateur.

Accédez au contenu du CD et double-cliquez sur le fichier EZ Vinyl Tape Converter.Installer.pkg
pour lancer le processus d'installation.

Suivez ensuite les instructions a I'écran pour faire l'installation du EZ Vinyl/Tape Converter.

Une fois l'installation terminée, vous pourrez trouver l'application EZ Vinyl/Tape Converter dans le
dossier Applications.
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RANSFERT DE MUSIQUE SUR ORDINATEUR

Une fois le logiciel installé, vous pouvez lancer I'enregistrement. Lancez le EZ Vinyl/Tape Converter en cliquant sur Démarrer
» Tous les programmes P EZ Vinyl Tape Converter (PC) ou au menu Applications (Mac).

ETAPE 1

Une fois I'application lancée, la fenétre de droite s'affiche.

Branchez un céble USB de l'appareil USB & un port USB sur votre

ordinateur. (Ce logiciel ne requiert que cette connexion audio afin de EZ Vinyl/Tape Converter

convertir vos enregistrements vinyles ou cassettes.)

Une fois I'appareil USB branché, cliquez sur Suivant.

Remarque : Si vous étes invité a sélectionner le dispositif de lecture audio

(Turntable (platine tourne-disque) ou Tape Player (lecteur cassettes)),

cochez la case appropriée et cliquez sur Next. Si vous avez coché Tape

Player (lecteur cassettes), vous serez invité a sélectionner le format de -
cassette, Normal ou Chrome. (Les cassettes normales sont le format le auvant
plus populaire, incluant les cassettes préenregistrées et les cassettes

d'enregistrement.)

Remarque : Si un message apparait vous indiquant que le EZ Vinyl/Tape Converter est incapable d'initialiser votre dispositif
USB, débranchez tous les autres périphériques audio USB (haut-parleurs USB, interfaces audio USB, etc.) de votre ordinateur,
puis cliquez de nouveau sur Suivant.

ETAPE 2

La fenétre de droite s'affiche.
Repérez le début de la section que vous désirez enregistrer. Nous vous
recommandons de controler les niveaux.
Si votre périphérique USB est doté d’'une commande de gain, veuillez la
régler adéquatement. Vous pouvez également régler la barre de défilement
dans le logiciel a c6té du vumetre du volume (les parties de la chanson ou il
le niveau du volume est plus élevé devraient atteindre la section orange du ekoen iy
vumetre).
Si vous n’étes toujours pas satisfait du niveau de gain apres I'ajustement
du niveau de gain dand le logiciel, la plupart des systemes d’exploitation Kb »
sont dotés d'une barre de défilement pour le réglage du niveau
d’enregistrement :
Windows XP : (non disponible)
Windows Vista : Cliquez sur Démarrer » Panneau de configuration (ou Parameétres » Panneau de configuration en
Affichage classique) » Matériel et audio » Son. Cliquez sur 'onglet Enregistrement et sélectionnez « USB audio
codec » comme périphérique par défaut. Sélectionnez Propriétés. Dans la nouvelle fenétre, cliquez sur 'onglet Niveaux et
réglez la barre de défilement Microphone en conséquence. Nous recommandons le niveau « 4 ».
Windows 7: Cliquez sur Démarrer » Panneau de configuration » Son. Cliquez sur l'onglet Enregistrement et
sélectionnez « USB audio codec » comme périphérique par défaut. Sélectionnez Propriétés. Dans la nouvelle fenétre,
cliquez sur I'onglet Niveaux et réglez la barre de défilement Microphone en conséquence. Nous recommandons le niveau
« 4,
Mac : Cliquez sur la pomme (logo Apple) située dans le coin supérieur gauche de I'écran et sélectionnez Préférences
Systeme > Sons. Cliquez sur l'onglet Entrée et veuillez vous assurer que le périphérique USB est en surbrillance. A partir
du menu, sélectionnez le périphérique d’enregistrement USB et réglez la barre du Volume d’entrée en conséquence.
Le logiciel permet de séparer les pistes automatiquement en détectant les périodes de silence dans la musique. Pour de
meilleurs résultats, veuillez vous assurer que les parties de la chanson ou le niveau du volume est plus élevé devraient
atteindre la section orange du vumeétre. Si le volume est trop faible, le EZ Vinyl/Tape Converter peut avoir plus de difficulté a
percevoir le son et les silences. Pour séparer les pistes manuellement, décochez I'option « Automatically split recording into
separate tracks » (Séparer automatiquement I'enregistrement en pistes). (Cette option est recommandée pour la musique
populaire, cependant, les résultats peuvent varier avec la musique classique, les créations parlées, etc.)
Lorsque vous étes prét a enregistrer, appuyez sur la touche Record, puis lancez immédiatement la musique (appuyez sur
« Play », placez l'aiguille sur le disque, etc.).

00:00:03

ETAPE 3

L'enregistrement est en cours. Les haut-parleurs de I'ordinateur devraient

diffuser le signal audio et les vumétres devraient indiquer qu'ils regoivent le

signal.

Si vous avez choisi de séparer les pistes manuellement, le bouton o
« Nouvelle piste » devrait s'afficher. Vous pouvez utiliser ce bouton pour
marquer le début de chaque nouvelle piste.

Une fois l'enregistrement terminé, cliquez sur Suivant pour passer a
I'étape suivante.

enregisuer
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ETAPE 4

Une fois I'enregistrement terminé, veuillez entrer le nom de l'artiste,

X
de l'album et de la piste en cliquant sur champs correspondants et en
y entrant le texte approprié.
Piste
Remarque: Si vous avez enregistré plus de 10 pistes, vous pouvez A
. e ; ) K ) . e
accéder a l'information des pistes 11 & 20 en cliquant sur Suivante.
e . Abum,
Lorsque vous avez terminé |'étiquetage de vos enregistrements,
cliquez sur Suivante. T
»
Le logiciel procédera a I'exportation de vos enregistrements vers
iTunes. Veuillez attendre que I'exportation soit terminée. %
ETAPE 5
Une fois que le logiciel a terminé d'exporter vos enregistrements vers X
iTunes, la fenétre de droite s'affiche.
Cliquez sur Yes si vous désirez faire un autre enregistrement.
Cliquez sur No si vous ne désirez plus faire d'enregistrement.
Lorsque vous avez fait votre choix, cliquez sur Next pour faire un
autre enregistrement ou pour quitter I'application.
»
ETAPE 6
Vous pourrez désormais accéder a vos e E o Corcs Sore rced b Tunes FIET)
enregistrements via votre bibliotheque )(>) + em—p 4 w =i
iTunes. Basculez sur la fenétre iTunes | v[tame T D o [
h ; - f v adkor 247 w0l Aot
(iTunes s’ouvre automatiquement une fois B o v Tackz Sie Aoz Aoumoz
les pistes exportées.) Cliquez a gauche sur | {1 e st prots
Fonglet Musique de la bibliotheque et | e s v
parcourez les catégories Artiste, Album et e ¢ Tk S0 a7 A7
v Tt 200 mistos Houncs
nom des morceaux que VOUS avez | v ks 201 anses Abumos
sélectionnés pour votre enregistrement. GeNIUs
puavusts
Afin de voir les morceaux récemment © fines 0
. < N T Y - . £ 90's Music
ajoutés a votre bibliotheque iTunes, cliquez 2 doscalius
sur le menu Présentation, sélectionnez i
comme liste, puis faites un clic droit (ou « st
ctrl » + sur un Mac) sur la catégorie Nom 48 Top 2 Mot lyed
au-dessus de la liste des morceaux. Dans la | . vmperemoe.
nouvelle fenétre, sélectionnez Date de Rl
I'ajout et cliquez sur OK. Au-dessus de la
liste des morceaux, cliquez sur la catégorie
Date de I'ajout. Votre morceau le plus — - — =
= 10 sngs, 27.8 minutes, 49,6 MB. & @

récent sera en téte de liste. (Vous pouvez 26D ®

cliquer sur la catégorie — Nom, Artiste, Date de I'ajout, etc. - en tout temps si vous désirez commander & nouveau les

morceaux affichés dans votre bibliothéque iTunes.)

A partir de iTunes, vous pouvez également graver vos enregistrements directement sur des CD ou les télécharger

sur votre iPod.

Veuillez consulter les menus d’aide iTunes pour de plus amples informations sur l'utilisation de iTunes.

Il se peut qu’aprés le transfert de musique sur votre I'ordinateur vous ayez a resélectionner la carte son
comme périphérique par défaut pour I'appareil de lecture audio. Autrement, vous n’aurez pas de son lors de

la lecture de musique sur votre ordinateur. Consultez la section Dépannage pour plus d’information.
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GUIDE DE DEPANNAGE

Je n'entends pas de
signal audio lors de
I'enregistrement et les
vumetres ne
démontrent aucune
activité.

L'appareil USB n'est pas
branchée.

Si votre périphérique dispose d'une touche d’alimentation, veuillez vous
assurer qu'il est mis en marche.

L'appareil USB n'est pas
connectée a l'ordinateur.

Veuillez vous assurer que I'appareil USB est connectée a un port USB de
I'ordinateur qui fonctionne. Si elle est branchée, essayez de la
débrancher et de la rebrancher puis de relancer I'application.

Cable ou port USB
défectueux.

Essayez avec un autre cable USB. Essayez également de brancher le
cable a un autre port USB de votre ordinateur.

La musique joue et je
vois les vumetres
s'activer, mais je
n'entends pas de
signal audio.

Le signal audio n'est pas
acheminé correctement.

Veuillez vous assurer que la carte de son de votre ordinateur est
sélectionnée comme appareil de lecture par défaut.

Windows XP : Clicquez sur Démarrer » Panneau de configuration (ou
Paramétres » Panneau de configuration en Affichage classique) » Sons
et périphériques audio. Cliquez sur 'onglet Audio et sélectionnez la
carte son de 'ordinateur comme périphérique de lecture audio par défaut.
Windows Vista : Clicquez sur Démarrer » Panneau de configuration
(ou Paramétres » Panneau de configuration en Affichage classique) »
Matériel et audio » Son. Cliquez sur l'onglet Lecture et sélectionnez la
carte son de 'ordinateur comme périphérique de lecture audio par défaut.
Windows 7 : Cliquez sur Démarrer » Panneau de configuration »
Son. Cliquez sur l'onglet Lecture et sélectionnez la carte son de
I'ordinateur comme périphérique de lecture audio par défaut.

Mac : Cliquez sur la pomme (logo Apple) située dans le coin supérieur
gauche de I'écran et sélectionnez Préférences Systéeme » Sons.
Cliquez sur I'onglet Sortie. A partir du menu, sélectionnez Haut-parleurs
internes si vous utilisez les haut-parleurs internes de I'ordinateur, ou
sélectionnez Ecouteurs si vous utilisez des haut-parleurs ou un casque
d’écoute branchés a la sortie casque (1/8 po) de votre ordinateur.

Les haut-parleurs de
l'ordinateur sont fermés.

Augmentez le volume des haut-parleurs de I'ordinateur.

Les haut-parleurs de
I'ordinateur ne sont pas
branchés.

Si vous utilisez des haut-parleurs externes, assurez-vous qu'ils sont
connectés a la carte de son de l'ordinateur.

Le son est de
mauvaise qualité.

La cartouche n'est pas fixée
correctement.

Si vous utilisez une table tournante USB, assurez-vous que la cartouche
est bien fixée sur le bras de lecture chaque fois que la table tournante est
utilisée.

Le vinyle est peut-étre sale
ou égratigné.

Si vous faites le transfert d'un disque vinyle, dépoussiérez-le doucement
avant de le faire jouer.

D'autres applications
interférent avec le EZ
Vinyl/Tape Converter.

Fermez toutes les applications, redémarrez I'ordinateur et ne lancez que
le EZ Vinyl/Tape Converter lors de I'enregistrement.

Votre pointe de lecture
(aiguille) pourrait étre brisée
ou usée.

Platines tourne-disques seulement : Si votre pointe de lecture (aiguille)
a plus d’'un an ou a été utilisée de maniere intensive, elle pourrait étre
brisée ou usée. Si tel est le cas, veuillez contacter le service des pieces
de rechange ION Audio afin de vous en procurer une nouvelle.

Le volume de
'enregistrement est
trop élevé etily a de
I'écrétage.

Le niveau de gain est trop
élevé.

L’enregistrement est a
peine audible.

Le niveau de gain est trop
faible.

Si votre périphérique USB est doté d’'une commande de gain, veuillez la
régler adéquatement. Vous pouvez également régler la barre de
défilement dans le logiciel a c6té du vumeétre du volume (les parties de la
chanson ol le niveau du volume est plus élevé devraient atteindre la
section orange du vumetre).

Si vous n’étes toujours pas satisfait du niveau de gain apres I'ajustement
du niveau de gain dand le logiciel, la plupart des systémes d’exploitation
sont dotés d’'une barre de défilement pour le réglage du niveau
d’enregistrement :

Windows XP : (non disponible)

Windows Vista : Cliquez sur Démarrer » Panneau de configuration
(ou Parametres » Panneau de configuration en Affichage classique) »
Matériel et audio » Son. Cliquez sur I'onglet Enregistrement et
sélectionnez « USB audio codec » comme périphérique par défaut.
Sélectionnez Propriétés. Dans la nouvelle fenétre, cliquez sur 'onglet
Niveaux et réglez la barre de défilement Microphone en conséquence.
Nous recommandons le niveau « 4 ».

Windows 7 : Cliquez sur Démarrer » Panneau de configuration »
Son. Cliquez sur 'onglet Enregistrement et sélectionnez « USB audio
codec » comme périphérique par défaut. Sélectionnez Propriétés. Dans
la nouvelle fenétre, cliquez sur I'onglet Niveaux et réglez la barre de
défilement Microphone en conséquence. Nous recommandons le niveau
«4 .

Mac : Cliquez sur la pomme (logo Apple) située dans le coin supérieur
gauche de I'écran et sélectionnez Préférences Systeme » Sons.
Cliquez sur 'onglet Entrée et veuillez vous assurer que le périphérique
USB est en surbrillance. A partir du menu, sélectionnez le périphérique
d’enregistrement USB et réglez la barre du Volume d’entrée en
conséguence.
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PROBLEME

Je ne peux pas entendre
mes enregistrements sur
mon ordinateur une fois
que je les ai transférés.

Lorsque le appareil USB
est branché, je n'entends
son provenant de mon
ordinateur.

CAUSE

La sortie audio n'est de
I'ordinateur n'est pas
réglé correctement.

SOLUTIO|

Veuillez vous assurer que la carte de son de votre ordinateur est
sélectionnée comme appareil de lecture par défaut.

Windows XP : Clicquez sur Démarrer » Panneau de configuration (ou
Paramétres » Panneau de configuration en Affichage classique) » Sons
et périphériques audio. Cliquez sur I'onglet Audio et sélectionnez la
carte son de I'ordinateur comme périphérique de lecture audio par défaut.
Windows Vista : Clicquez sur Démarrer » Panneau de configuration
(ou Parametres » Panneau de configuration en Affichage classique) »
Matériel et audio » Son. Cliquez sur I'onglet Lecture et sélectionnez la
carte son de I'ordinateur comme périphérique de lecture audio par défaut.
Windows 7 : Cliquez sur Démarrer » Panneau de configuration »
Son. Cliquez sur l'onglet Lecture et sélectionnez la carte son de
I'ordinateur comme périphérique de lecture audio par défaut.

Mac : Cliquez sur la pomme (logo Apple) située dans le coin supérieur
gauche de I'écran et sélectionnez Préférences Systéeme » Sons.
Cliquez sur I'onglet Sortie. A partir du menu, sélectionnez Haut-parleurs
internes si vous utilisez les haut-parleurs internes de I'ordinateur, ou
sélectionnez Ecouteurs si vous utilisez des haut-parleurs ou un casque
d’écoute branchés a la sortie casque (1/8 po) de votre ordinateur.

Sur Windows Vista ou
Windows 7, mes
enregistrements sont
mono au lieu d'étre en
stéréo.

Les paramétres d'entrée
pour I'enregistrement ne
sont pas réglés a

« stéréo ».

Il se peut que vous deviez régler manuellement I'entrée d'enregistrement
a « stéréo ».

Allez 2 Démarrer » Panneau de configuration » Son (mode de
visualisation classique). Cliquez ensuite sur I'onglet Enregistrement et
mettez I'entrée Microphone en surbrillance (USB Audio Codec). Cliquez
sur Propriétés pour voir les paramétres d'entrée. Cliquez ensuite sur
I'onglet Avancé et sélectionnez « 2 canaux, 16 bits, 44100 Hz (qualité
CD) » dans le menu déroulant Format par défaut. Puis, cliquez sur
Appliquer pour confirmer les réglages.

Apres avoir enregistré un
fichier sur mon Mac, le
fichier apparait comme

« EZACT Temp » dans
iTunes, mais je ne peux le
faire jouer.

Les parameétres de
iTunes doivent étre
réglés.

Dans iTunes, cliquez sur le menu supérieur gauche et cliquez sur
Préférences. Cliquez sur I'onglet Général, puis sur le bouton Réglages
d'importation et réglez le champ Importez via a Encodeur MP3. Cliquez
ensuite sur l'onglet Lecture et décochez les champs Lecture en fondu,
Correcteur de son et Egaliseur de volume. Fermez la fenétre.

Le son provenant des
sorties de mon
périphérique audio USB
est déformé ou plein de
statique.

Le sélecteur ligne/phono
peut étre incorrectement
réglé.

Platines tourne-disques seulement : Si votre périphérique USB dispose
d’un sélecteur ligne/phono sur son panneau arriére, veuillez vous assurer
qu'il est correctement réglé pour I'entrée a laquelle il est branché (ligne ou
phono). Si votre périphérique ne dispose pas de sélecteur, veuillez
consulter le guide d'utilisation simplifié fourni avec le produit afin de
déterminer s'il est a niveau ligne ou phono.

Remarque : Vous n’avez pas a brancher votre périphérique USB a un

systéme de sonorisation, a un récepteur, etc., pour que le EZ Vinyl/Tape
Converter convertisse votre musique. Vous n’avez qu’a le brancher a
votre ordinateur en utilisant un cable USB.

FOIRE AUX QUESTIONS

Question : Avec quels systémes d'exploitation le EZ Vinyl/Tape Converter est-il compatible?
Réponse : Le EZ Vinyl/Tape Converter est actuellement compatible avec les systémes d’exploitation Windows XP, Vista et 7
(32 bits ou 64 bits), ainsi que Mac OS X 10.4.11 et les versions ultérieures.

Question : En quel format mes enregistrements sont-ils convertis?

Réponse : Les enregistrements sont convertis en fichiers MP3 selon le débit binaire sélectionné dans les Réglages
d’importation de votre iTunes. Pour visionnez/modifier ces réglages a partir de I'application iTunes, cliquez sur le menu iTunes,
puis sélectionnez Préférences, sous I'onglet Général, cliquez sur le bouton Réglages d’importation... Cliquez sur le menu
déroulant Importer via et sélectionnez le format Encodeur MP3. Vous pourrez maintenant sélectionner le débit binaire désiré
a partir du menu déroulant Réglages.

Question : OU mes enregistrements sont-ils sauvegardés par défaut sur mon ordinateur?

Réponse : Vos enregistrements sont sauvegardés dans le dossier Musique de iTunes. Par défaut, sur Windows, ce dossier est
situé dans Mes documents » Ma musique » iTunes » iTunes Music, ou sur Mac Musique » iTunes » iTunes Music et
le contenu est organisé par nom d'artiste.

Question : Comment faire pour graver mes enregistrements sur un CD?

Réponse : Il y a plusieurs fagons de graver vos enregistrements sur un CD. Il est possible d'utiliser iTunes ou un autre logiciel
de gravure. Pour graver un CD a partir de iTunes, vous devez créer une liste de lecture et glissez-déposez les chansons
(morceaux) de votre bibliotheque dans cette liste. Lorsque vous avez ajouté toutes les pistes voulues et vérifié qu’elles étaient
toutes cochées, cliquez sur la liste de lecture, puis sur le bouton Graver. Veuillez consulter le menu d'aide de iTunes ou du
logiciel de gravure que vous désirez utiliser pour plus d'information.

Question : Puis-je écouter mes enregistrements via mon ordinateur durant I'enregistrement?

Réponse : Oui, le EZ Vinyl/Tape Converter contrlent automatiquement tout signal audio entrant par votre ordinateur en méme
temps que la musique est transférée. Si vous utilisez plusieurs appareils audio, nous vous recommandons de désactiver les
appareils que vous ne désirez pas utiliser en ce moment pour écouter la musique. Pour la plupart des utilisateurs, ceci ne sera
pas un probléme.
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INTRODUZIONE

Benvenuti allEZ Vinyl/Tape Converter — il modo piu semplice di trasferire le vostre registrazioni al vostro
computer. Questo software funziona con iTunes®, consentendo di masterizzare le proprie registrazioni su
CD o di trasferirle a un dispositivo media digitale portatile. Ci auguriamo che apprezzerete I'uso di questo
prodotto tanto quanto noi ci siamo divertiti a progettarlo per voi!

INSTALLAZIONE DEL SOFTWARE - PC

1. Inserire il CD in dotazione nel lettore CD del computer.

2. Una finestra a pop up dovrebbe aprirsi automaticamente. Selezionare la tua lingua.

3.  Cliccare sul tasto EZ VINYL/TAPE CONVERTER per lanciare il processo d'installazione.

4. Seguire le istruzioni su schermo per installare 'EZ Vinyl/Tape Converter.

5. Una volta che I'EZ Vinyl/Tape Converter & stato installato con successo, fare clic sul pulsante iTunes
per installare iTunes.
Nota bene: I'EZ Vinyl/Tape Converter funziona con iTunes per convertire le tue registrazioni sul
computer. Prima di avviare il software EZ Vinyl/Tape Converter, occore installare iTunes sul computer.

6.  Seguire le istruzioni su schermo per installare iTunes.

7. Una volta che l'installazione di iTunes & stata completata con successo, fare clic sul pulsante EXIT per

uscire.
8. EZ Vinyl/Tape Converter e iTunes sono ora stati installati con successo sul vostro computer!

INSTALLAZIONE DEL SOFTWARE - MAC

1. Inserire il CD in dotazione nel lettore CD del computer.

2 Aprire i contenuti del CD e fare doppio clic sul file EZ Vinyl Tape Converter.Installer.pkg per avviare il
processo di installazione.

3. Seguire le istruzioni su schermo per installare 'EZ Vinyl/Tape Converter.

4. Una volta completato il processo di installazione, I'applicazione EZ Vinyl/Tape Converter si trovera

nella cartella Applicazioni.
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COMPUTER

Una volta installato il software, si pud avviare la registrazione. Aprire 'EZ Vinyl/Tape Converter recandosi su Start » Tutti i
programmi » EZ Vinyl Tape Converter (PC) oppure al menu Applicazioni (Mac).

FASE 1

Una volta lanciato il software, apparira la schermata illustrata a destra.

Collegare il cavo USB dal dispositivo USB ad una porta USB disponibile

del computer. (Questo & l'unico collegamento audio che occorre EZ Vinyl/Tape Converter

effettuare per convertire vinili o nastri utilizzando questo software.)

Una volta che il dispositivo USB & collegato, cliccare su Next.

Nota bene: se viene richiesto di selezionare il proprio dispositivo di

riproduzione (giradischi o lettore di nastri), spuntare la casella

adeguata e cliccare su Avanti. Se viene selezionato lettore di nastri,

verra richiesto di selezionare il formato del nastro tra, Normale o

Cromo. (I nastri normali sono i piut comuni e comprendono i nastri »
acquistati in negozio e quelli registrati a casa.)

Nota bene: se viene visualizzato un messaggio che indica che I'EZ Vinyl/Tape Converter non & in grado di inizializzare il vostro
dispositivo USB, scollegare qualsiasi altro dispositivo USB audio (casse USB, interfacce audio USB, ecc. dal computer, quindi
cliccare nuovamente su Next (avanti).

FASE 2

Apparira la schermata illustrata a destra.
Individuare l'inizio della sezione che si desidera registrare. Prima di
iniziare la registrazione, si raccomanda di verificare i livelli.
Se il dispositvo USB & dotato di un controllo "gain”, regolarlo 5
adeguatamente. E anche possibile regolare il cursore gain nel software
accanto al misuratore del livello del volume (la parte piu rumorosa della
canzone deve raggiungere la parte arancione del misuratore).
Se non si & soddisfatti del livello del gain anche dopo aver regolato il
cursore del gain del software, la maggior parte dei sistemi operativi dei
computer sono dotati di un cursore per il livello dellingresso di
registrazione, che & regolabile:
Windows XP: (non disponibile)
Windows : cliccare su Start » Pannello di controllo (o Impostazioni» Pannello di controllo in visualizzazione
classica) » Hardware e suoni » Audio. Cliccare sulla scheda Registrazione e selezionare "USB Audio Codec" come
periferica predefinita. Cliccare su Proprieta. Nella finestra successiva, cliccare sulla scheda Livelli e regolare
adeguatamente il cursore Microfono. Si consiglia di impostare il livello su "4."

Windows 7: cliccare su Start » Pannello di controllo » Audio. Cliccare sulla scheda Registrazione e selezionare
"USB Audio Codec" come periferica predefinita. Cliccare su Proprieta. Nella finestra successiva, cliccsre sulla scheda
Livelli e regolare adeguatamente il cursore Microfono. Si consiglia di impostare il livello su "4."

Magc: cliccare sullicona della "mela” in alto a sinistra, quindi cliccare su Preferenze di sistema » Audio. Cliccare sulla

scheda Input e assicurarsi che il dispositivo USB sia evidenziato. Nel menu, selezionare il dispositivo di registrazione

USB e regolare il cursore Input Volume adeguatamente.
Il software suddividera le tracce automaticamente quando individua parti silenziose nella musica. Per ottenere i migliori risultati,
assicurarsi che i livelli di volume raggiungano la parte arancione del misuratore di volume del software durante le parti piu
rumorose della canzone. Se il volume & troppo basso, I'EZ Vinyl/Tape Converter puo avere difficolta a individuare la differenza
tra suono e silenzio. Per suddividere le tracce manualmente, togliere il segno di spunta dalla casella contrassegnata
"Suddivisione automatica della registrazione in tracce distinte” (“Automatically split recording into separate tracks”) o "Suddividi
la registrazione in tracce" ("Split recording into tracks"). (Questo & raccomandato per la musica pop tipica, ma puo produrre vari
risultati se utilizzato con altri generi quali musica classica, parlato, ecc.)

Quando si & pronti a iniziare la registrazione, cliccare su Record (registra) e riprodurre immediatamente la musica (premere
"play", collocare la puntina sul disco, ecc.).

B

back record

FASE 3

Ora state registrando. Si dovrebbe sentire l'audio proveniente dal
dispositivo attraverso le casse del computer e vedere i misuratori audio
che si muovono.

Se si sceglie di suddividere manualmente la registrazione in tracce,
apparira un tasto "New Track" (nuova traccia). Servirsi di tale tasto per

demarcare l'inizio di una nuova traccia. recording time: 000025
Una volta finito di registrare, cliccare su Next per passare alla fase [Eatding rack:  Aifialic
successiva.

»

back next
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FASE 4

Una volta finito di registrare, inserire Artista, Album e Titolo della X
traccia, cliccando e digitando le informazioni nei campi
corrispondenti.

Nota bene: se sono state registrate piu di 10 tracce, si pud
accedere alle informazioni relative alle tracce 11-20 cliccando su -
Next. Abum:

Una volta terminato di etichettare le registrazioni, cliccare su Next. Track tite:

Track: [1

»

Il software esportera ora le registrazioni su iTunes. Attendere che 5

X
il processo sia completato.
FASE 5
Una volta che il software ha esportato le registrazioni su iTunes, X
apparira la schermata a destra.
Scegliere Yes se si desidera registrare ancora.
Scegliere No se non si desidera registrare altro.
Una volta effettuata la scelta, cliccare su Next per registrare yes "
ancora o uscire dall'applicazione.
»

FASE 6

R - e o Cov o Rl e Trunes Taw
Da questo momento & possibile accedere alle tue » . —_— :

() () + e 3 Bl =om) (@sea

¥ Name. Time Artist < album

registrazioni attraverso la libreria di iTunes.
Passare alla finestra di iTunes (iTunes si aprira
automaticamente una volta che le canzoni saranno
state esportate). Fare clic su Music (Musica) nel

v Tkl 247 rstor Abum o1
v Tk a8 w2 Abumcz
v Tk Lt arts Abumos
v Tkos 328 A 0s Abum o4
v ks 312 Ateos Aoum s

tab libreria a sinistra e spostarsi attraverso i titoli :mjﬁﬁ prepa f:mf;
dell'artista, dell'album e della canzone che hai | sww v Tk sns
inserito per la tua registrazione.
Per consultare le nuove canzoni aggiunte alla e
libreria di iTunes, fare clic sul menu View (Vista), Lo
selezionare As List (Come elenco), quindi fare clic | Zu7v,
con il tasto destro del mouse (oppure con “ctrl" + e s
i . . % Top 25 vost Played
clic tasto Mac) sulla categoria Name (Nome) in e
alto nell'elenco dei brani. Nel menu che appare 2 s

spuntare la voce Date Added (Data aggiunta) e
fare clic su OK. In alto sull'elenco dei brani, fare
clic sulla categoria Date Added (Data aggiunta). . .
Le nuove canzoni appariranno in cima all'elenco. T e n L e b o
(Puoi fare clic sulla categoria -Nome, Artista, Data aggiunta, ecc- ogni volta che vuoi per riordinare le canzoni
visualizzate nella libreria iTunes).

Da iTunes, puoi masterizzare le tue registrazioni direttamente su CD oppure caricarle sul tuo iPod.
Si consiglia di consultare il menu Aiuto per maggiori informazioni su come usare iTunes.

E bene notare che dopo aver trasferito la musica nel tuo computer, potrebbe essere necessario riselezionare
la scheda audio del tuo computer e la funzione playback. In caso contrario, non sarai in grado di sentire
alcun suono quando riproduci file audio del tuo computer. Per maggiori informazioni consultare il Manuale
utente.
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Non si sente l'audio durante la
registrazione e non si vedono i
misuratori dell'audio muoversi.

CAUSA

Il dispositivo USB non &
acceso.

SOLUZIONE

Se il dispositivo USB dispone di un pulsante di accensione,
assicurarsi che sia acceso.

Il dispositivo USB non &
collegato al computer.

Assicurarsi che il dispositivo USB sia collegato ad una porta USB
funzionante del computer. Se gia collegato, provare a ricollegare
il dispositivo e a riavviare il software.

Cattivo cavo USB o cattiva
porta USB.

Provare a servirsi di un cavo USB diverso. Provare a collegare il
dispositivo USB ad una diversa porta USB del computer.

La musica viene riprodotta e
vedo i misuratori audio che si
muovono, ma non sento alcun
audio.

L'uscita audio non &
impostata correttamente.

Assicurarsi che la scheda audio del computer sia selezionata
quale dispositivo di riproduzione.

Windows XP: cliccare su Start » Pannello di controllo (o
Impostazioni» Pannello di controllo in visualizzazione classica)
» Suoni e periferiche audio. Cliccare sulla scheda Audio e
sotto Riproduzione suoni, selezionare la scheda audio del
computer come periferica predefinita.

Windows Vista: cliccare su Start » Pannello di controllo (o
Impostazioni» Pannello di controllo in visualizzazione classica)
» Hardware e suoni » Audio. Cliccare sulla scheda
Riproduzione e selezionare la scheda audio del computer come
periferica predefinita.

Windows 7: cliccare su Start » Pannello di controllo »
Audio. Cliccare sulla scheda Riproduzione e selezionare la
scheda audio del computer come periferica predefinita.

Mac: cliccare sull'icona della "mela” in alto a sinistra, quindi
cliccare su Preferenze di sistema » Audio. Fare clic sulla
linguetta Output . Nel menu, selezionare Casse interne se si
utilizzano le casse del computer e selezionare Headphones
(cuffie) se si stanno utilizzando casse o cuffie collegate all'uscita
cuffie da 1/8" del computer.

Le casse del computer sono
silenziate.

Alzare il volume delle casse.

Le casse del computer non
sono collegate.

Se si utilizzano casse esterne, assicurarsi che siano collegate
alla scheda audio del computer.

La qualita del suono é scarsa.

La cartuccia non & ben
fissata.

Se si utilizza un giradischi USB, la cartuccia deve essere fissata
saldamente al braccio ogniqualvolta si utilizza il giradischi stesso.

Il disco in vinile & sporco o
graffiato.

Se si trasferiscono vinili, provare a spolverare delicatamente con
un panno la superficie del disco prima di riprodurlo.

Altre applicazioni software
interferiscono con I'EZ
Vinyl/Tape Converter.

Chiudere tutte le applicazioni, riavviare il computer e lanciare
unicamente I'EZ Vinyl/Tape Converter durante la registrazione.

La puntina potrebbe essere
rotta o usurata.

Solo giradischi: se la puntina ha pit di un anno o & stata
utilizzata abbondantemente, potrebbe essere rotta o usurata.
Contattare il reparto parti di ricambio di ION Audio per acquistare
un‘altra puntina.

Le registrazioni suonano alte e
distorte.

Il livello Gain & troppo
elevato.

La registrazione & appena
udibile.

Il livello gain & troppo basso.

Se il dispositivo USB & dotato di un controllo "gain”, regolarlo
adeguatamente. E anche possibile regolare il cursore gain nel
software accanto al misuratore del livello del volume (la parte pitu
rumorosa della canzone deve raggiungere la parte arancione del
misuratore).
Se non si & soddisfatti del livello del gain anche dopo aver
regolato il cursore del gain del software, la maggior parte dei
sistemi operativi dei computer sono dotati di un cursore per il
livello dellingresso di registrazione, che & regolabile:

dows XP: (non disponibile)

dows Vista: cliccare su Start » Pannello di controllo (o
Impostazioni» Pannello di controllo in visualizzazione classica)
» Hardware e suoni » Audio. Cliccare sulla scheda
Registrazione e selezionare "USB Audio Codec" come
periferica predefinita. Cliccare su Proprieta. Nella finestra
successiva, cliccare sulla scheda Livelli e regolare
adeguatamente il cursore Microfono. Si consiglia di impostare il
livello su "4."

dows 7: cliccare su Start » Pannello di controllo » Audio.
Cliccare sulla scheda Registrazione e selezionare "USB Audio
Codec" come periferica predefinita. Cliccare su Proprieta. Nella
finestra successiva, cliccsre sulla scheda Livelli e regolare
adeguatamente il cursore Microfono. Si consiglia di impostare il
livello su "4."
Mac: cliccare sull'icona della "mela” in alto a sinistra, quindi
cliccare su Preferenze di sistema » Audio. Cliccare sulla
scheda Input e assicurarsi che il dispositivo USB sia evidenziato.
Nel menu, selezionare il dispositivo di registrazione USB e
regolare il cursore Input Volume adeguatamente.
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Assicurarsi che la scheda audio del computer sia selezionata

Non e possibile ascoltare le quale dispositivo di riproduzione.

registrazioni una volta Windows XP: cliccare su Start » Pannello di controllo (o
trasferite, quando si cerca di Impostazioni > Pannello di controllo in visualizzazione classica)
riprodurle sul computer. » Suoni e periferiche audio. Cliccare sulla scheda Audio e

sotto Riproduzione suoni, selezionare la scheda audio del
computer come periferica predefinita.

Windows Vista: cliccare su Start » Pannello di controllo (o
Impostazioni » Pannello di controllo in visualizzazione classica)

L'uscita audio del computer » Hardware e suoni » Audio. Cliccare sulla scheda

non & impostata Riproduzione e selezionare la scheda audio del computer come

correttamente. periferica predefinita.
Quando il giradischi & Windows 7: cliccare su Start » Pannello di controllo »
collegato non sento alcuna Audio. Cliccare sulla scheda Riproduzione e selezionare la
musica dal mio computer scheda audio del computer come periferica predefinita.

Mac: cliccare sull'icona della "mela” in alto a sinistra, quindi
cliccare su Preferenze di sistema » Audio. Fare clic sulla
linguetta Output . Nel menu, selezionare Casse interne se si
utilizzano le casse del computer e selezionare Headphones
(cuffie) se si stanno utilizzando casse o cuffie collegate all'uscita
cuffie da 1/8" del computer.

Va specificato "stereo" per l'ingresso di registrazione.

Recarsi su Start B Pannello di controllo » Suono (in Visuale
Classica). Quindi, cliccare sulla linguetta Registrazione ed

Su Windows Vista o Windows Le proprieta di ingresso di - A o > > =
7o etionsono | regtaonononsono | gedrzare lngess Mirlono (U9 AudoCodeo) Clocare s
mono anziché stereo. impostate su "stereo". P! P! P 9 N g

cliccare sulla linguetta Avanzate e selezionare "2 canali, 16 bit,
44100 Hz (qualita CD)" nel menu a tendina Formato predefinito.
Infine, cliccare su Applica per accettare le impostazioni.

In iTunes, cliccare sul menu iTunes situato nell'angolo
superioresinistro e quindi su Preferences. Cliccare sulla scheda

Sul mio Mac, dopo aver
registrato un file, questo

a Le impostazioni di iTunes General, quindi sul pulsante Import Settings e impostare Import
%omp".’.".e come EZACT . devono essere regolate. Using su MP3 Encoder. Quindi cliccare sulla scheda Playback e
emp” in iTunes e non viene
. spuntare Sound Check, Sound Enhancer e Crossfade Songs.
riprodotto. " N .
Una volta terminato, chiudere la finestra.
Solo giradischi: se il dispositivo USB dispone di un interruttore
linea/phono a livello del pannello posteriore, assicurarsi che sia
impostato sul livello adeguato per gli ingressi cui & collegato
Il suono proveniente dalle L'interruttore a livello di ("linea" o "phono"). Se il dispositivo USB non dispone di questo
uscite audio del mio linea/phono potrebbe non interruttore, si veda la Guida rapida in dotazione con il prodotto
dispositivo USB & distorto o essere impostato per stabilire se ¢ a livello di linea o phono.
ricco di elettricita statica. correttamente. Nota bene: non occorre collegare il dispositivo USB ad un

sistema di altoparlanti, ricevitori, ecc. affinché I'EZ Vinyl/Tape
Converter converta la vostra musica. Bastera collegarlo al
computer (servendosi di un cavo USB).

DOMANDE FREQUENTI - FA

Domanda: Con quali sistemi operativi € compatibile I'EZ Vinyl/Tape Converter?
Risposta: EZ Vinyl/Tape Converter & attualmente compatibile con i sistemi operativi Windows XP, Vista e 7 (a 32 o 64 bit),
oltre al sistema operativo Mac OS X 10.4.11 (o superiore).

Domanda: In quale formato digitale vengono convertite le mie registrazioni?

Risposta: Le registrazioni sono trasformate in file MP3 a qualsiasi bitrate venga selezionato in Import Settings di iTunes. Per
visualizzare/modificare queste impostazioni, in iTunes, cliccare sul menu Edit, selezionare Preferenze, selezionare la scheda
Generale e cliccare sul pulsante Import Settings (importa impostazioni). Cliccare sul menu a discesa Import Using e
selezionare MP3 Encoder. Sara ora possibile selezionare il bitrate desiderato dal menu a discesa Setting.

Domanda: Dove sono salvate le mie registrazioni sul computer?

Risposta: Le vostre registrazioni verranno salvate nella cartella Musica di iTunes. In via predefinita, questa cartella si trova in
Documenti » Musica P> iTunes » Musica iTunes su Windows OS, oppure in Musica P> iTunes P> Musica iTunes su Mac
OS e i contenuti sono organizzati per nome di Artista.

Domanda: Come si fa a masterizzare le registrazioni su CD?

Risposta: Vi sono molti modi diversi di masterizzare le registrazioni su un CD. Si puo utilizzare iTunes o un'altra applicazione
di masterizzazione CD. Per masterizzare un CD utilizzando iTunes, creare una nuova Playlist, trascinare le canzoni dalla
libreria normale a questa Playlist. Una volta aggiunte tutte le tracce desiderate, cliccare su quella Playlist, quindi cliccare sul
tasto Burn Disc (masterizza disco). Consultare il menu di Aiuto di iTunes o della vostra applicazione preferita per maggiori
informazioni.

Domanda: Posso ascoltare la musica sul computer mentre registro?

Risposta: Si, I'EZ Vinyl/Tape Converter monitora automaticamente I'audio in ingresso tramite il computer man mano che la
musica viene trasferita. Se si utilizza piu di un dispositivo audio, si raccomanda di disattivare qualsiasi dispositivo non si
desideri utilizzare per la riproduzione. Per la maggior parte degli utenti, tuttavia, questo non sara un problema.
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Herzlichen Gluckwunsch zum Kauf des EZ Vinyl/Tape Converter — dem leichtesten Weg, Ihre Aufnahmen
auf Inren Computer zu Ubertragen. Diese Software funktioniert nahtlos mit iTunes® und ermdglicht es, alle
Ihre Aufnahmen auf CDs zu brennen oder auf ein tragbares Mediengerat zu Gberspielen. Wir hoffen, dass
Sie bei der Verwendung dieses Produkts genau so viel Vergnigen haben, wie wir bei dessen Entwicklung
hatten!

SOFTWARE-INSTALLATION AUF PC

apODd =

6.
7.

8.

Legen Sie die beiliegende CD in das CD-Laufwerk Ihres Computers ein.

Ein Dialogfenster sollte automatisch erscheinen. Wahlen Sie bitte ,Deutsch®, “English” oder “French.”
Klicken Sie auf EZ VINYL/TAPE CONVERTER, um mit der Installation zu beginnen.

Folgen Sie den Bildschirmanweisungen, um den EZ Vinyl/Tape Converter zu installieren.

Sobald der EZ Vinyl/Tape Converter erfolgreich installiert worden ist, klicken Sie auf iTunes, um
iTunes zu installieren.

Achtung: EZ Vinyl/Tape Converter arbeitet mit iTunes, um lhre Aufnahmen auf Ilhren Computer zu
libertragen.Bevor Sie die EZ Vinyl/Tape Converter Software starten, muss iTunes auf lhrem Computer
installiert sein.

Folgen Sie den Bildschirmanweisungen, um iTunes zu installieren.

Sobald die Installation von iTunes erfolgreich abgeschlossen worden ist, klicken Sie auf EXIT, um das
Programm zu schlief3en.

EZ Vinyl/Tape Converter und iTunes sind nun auf Inrem Computer installiert!

SOFTWARE-INSTALLATION AUF MAC

1.

Legen Sie die beiliegende CD in das CD-Laufwerk Ihres Computers ein.

Offnen Sie die CD und starten Sie die Installation mit einem Doppelklick auf die Datei EZ Vinyl Tape
Converter.Installer.pkg.

Folgen Sie den Bildschirmanweisungen, um den EZ Vinyl/Tape Converter zu installieren.

Sobald die Installation beendet ist, befinden sich das EZ Vinyl/Tape Converter-Programm in Ihrem
Applications-Verzeichnis.
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SIK AUF COMPUTER UBERTRAGEN

Ist das Programm installiert, kann mit der Aufnahme begonnen werden. Rufen Sie das Programm iber Start P Alle
Programme P EZ Vinyl Tape Converter (PC) auf oder indem Sie zum Menti Programme (Mac) gehen.

SCHRITT 1

Sobald das Programm aufgerufen wird, erscheint der rechts gezeigte

Bildschirm.

SchlieBen Sie ein USB-Gerét Uber ein USB-Kabel an einen freien USB- EZ Audio Converter

Port an Ihren Computer an. (Dies ist die einzige Audio-Verbindung, die

Sie vornehmen missen, um lhre Schallplatten oder Kassetten mit dieser

Software zu konvertieren.)

Sobald das Gerat angeschlossen ist, klicken Sie auf weiter.

Hinweis: Falls eine Aufforderung erscheint, die Wiedergabequelle

anzugeben (Plattenspieler oder K ekorder), das jeweilige

Késtchen markieren und dann auf Next klicken. Falls ein »
Kassettenrekorder gewahit wurde, erfolgt eine weitere Aufforderung,

das Kassettenformat zu wéahlen, Normal oder Chrome. (Normale

Kassetten sind am gebrauchlichsten, einschlieBlich in Laden und zum privaten Aufnahmegebrauch gekaufter Kassetten.)
Hinweis: Wenn Sie die Meldung erhalten, dass EZ Vinyl/Tape Converter lhr USB-Gerat nicht initialisieren kann, trennen Sie
alle anderen USB-Audio-Gerate (USB-Lautsprecher, USB-Audio-Interfaces etc.) von Ihrem Computer und klicken dann Weiter.

SCHRITT 2

Der rechts gezeigte Bildschirm erscheint.
Finden Sie den Anfang des Stiicks, welches aufgenommen werden soll.
Wir empfehlen, vor Beginn der Aufnahme die Lautstérkepegel zu
Uberprifen.
Wenn |hr USB-Gerat einen "Gain'-Regler hat, stellen Sie ihn
entsprechend ein. Sie kénnen auch den Gain-Schieberegler in der
Software neben der Pegelanzeige einstellen (der lauteste Teil des Songs 35
sollte den orangen Bereich der Anzeige erreichen).
Wenn Sie selbst dann noch nicht mit Inrem Pegel zufrieden sind, bieten
die meisten Computer-Betriebssysteme einen Aufnahme-
Eingangspegelregler, den Sie anpassen kénnen:
Windows XP: (nicht verfugbar)
Windows Vista: Klicken Sie auf Startmenii » Systemsteuerung (oder Einstellungen » Systemsteuerung in der
klassischen Ansicht) » Hardware und Sound » Ton. Klicken Sie auf die Registerkarte Aufnahme und wéhlen Sie "USB
Audio Codec" als Standard-Gerat aus. Klicken Sie auf Eigenschaften. Im neuen Fenster klicken Sie auf die Registerkarte
Pegel und stellen den Schieberegler Mikrofon entsprechend ein. Wir empfehlen, den Pegel auf "4" einzustellen.
Windows 7: Wé&hlen Sie Startmenii » Systemsteuerung » Ton. Klicken Sie auf die Registerkarte Aufnahme und
wéhlen Sie "USB Audio Codec" als Standard-Gerét aus. Klicken Sie auf Eigenschaften. Im neuen Fenster klicken Sie auf
die Registerkarte Pegel und stellen den Schieberegler Mikrofon entsprechend ein. Wir empfehlen, den Pegel auf "4"
einzustellen.
Mac: Klicken Sie auf das obere linke "Apfel"-Symbol und dann auf Systemeinstellungen » Ton. Klicken Sie auf die
Registerkarte Eingang und stellen Sie sicher, dass |hr USB-Gerat markiert ist. Aus dem Menu wahlen Sie |hr USB-
Aufnahmegerét und passen den Schieberegler des Eingangspegels entsprechend an.
Die Software teilt die Tracks automatisch auf, sobald eine Pause in der Musik erkannt wird. Die besten Ergebnisse erzielen Sie,
wenn Sie daflir sorgen, dass der Lautstarkepegel beim lautesten Teil des Songs den orangen Bereich der Anzeige in lhrer
Software erreicht. Wenn lhre Lautstérke zu niedrig ist, kann EZ Vinyl/Tape Converter Schwierigkeiten haben, den Unterschied
zwischen Musik und Stille zu erkennen. So teilen Sie die Tracks manuell: Deaktivieren Sie das Kontrollkastchen "Aufnahme
automatisch in einzelne Tracks aufteilen" oder "Aufnahme in einzelne Tracks aufteilen." (Wir empfehlen dies fir typische
Popmusik. Es kann jedoch méglicherweise zu unterschiedlichen Ergebnissen kommen, wenn diese Funktion bei anderen
Genres wie Klassik, Spoken Word etc. verwendet wird).
Wenn Sie bereit sind, die Aufnahme zu starten, klicken Sie auf Aufnahme und spielen sofort Ihre Musik (driicken Sie
"Wiedergabe", setzen Sie die Nadel auf die Platte etc.).

SCHRITT 3

Jetzt lauft die Aufnahme. Sie sollten Téne von |hrem Gerét (ber die
Lautsprecher des Computers héren und die Lautstarkenmesser sollten
sich bewegen.
Falls Sie sich dafiir entschieden haben, lhre Aufnahme manuell in
einzelne Musikstiicke aufzuteilen, werden Sie das Meni “New Track”
sehen. Sie konnen Uber dieses Meni den Beginn eines neuen Aufnahmezeit:  00:00:04
Musikstlicks markieren. Aufnahmetitel:  Automatisch
Ist die Aufnahme beendet, klicken Sie auf weiter, um zum né&chsten
Schritt zu gelangen.
»

weier
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SCHRITT 4

Geben Sie nun in dieser Anzeige den Namen des Kiinstlers, das
Album und die Titelbezeichnung in die jeweiligen Felder ein.
Hinweis: Falls Sie mehr als 10 Titel aufgenommen, kénnen Sie
die Titelinformationen fir die Titel 11-20 auf der nédchsten Seite
eingeben. Klicken Sie auf weiter.

Wenn Sie mit dem Benennen Ihrer Titel fertig sind, klicken Sie auf
weiter.

Die Software exportiert nun lhre Aufnahmen nach iTunes. Bitte
warten Sie, bis dieser Vorgang abgeschlossen wurde.

SCHRITT 5

Nachdem die Software Ihre Titel in iTunes importiert hat, sehen
Sie die hier rechts gezeigte Ansicht.

Mit ja beginnen Sie eine neue Aufnahme.

Waéhlen Sie nein, falls Sie keine neue Aufnahme machen
mdochten.

Nachdem Sie lhre Auswahl getroffen haben, klicken Sie auf
weiter, um entweder die nachste Aufnahme zu starten oder um
das Programm zu verlassen.

SCHRITT 6

pod[=]g!

Track: [t
Kinstler: |
Album:

Titelname:

»

Bitte warten Sie wihrend EZ Vinyl/Tape Converter Ihre Titel
2zuiTunes bertrégt.

»

lhre Aufnahmen zugreifen. Wechseln Sie zu

Fle Edt Vew Contiok Store Advanced Feb

Nun kénnen Sie dber lhre iTunes Bibliothek auf @ (5)(2) + e

iTunes (<=1

@ Bl=|= =) (Qse

lhrem iTunes-Fenster (iTunes o6ffnet sich

LIBRARY V Name
s v Trackol
5 Movtes v Trackoz

automatisch, sobald |hre Tracks exportiert S 1vshons v Trakas

i Rado v Trackos

Time Artist + Album
247 anstol Abumol
318 mtstez Abumoz
144 Artstos Abum0s
328 mtstot Abum o4

wurden.) Klicken Sie auf der linken Seite auf
die Registerkarte Musikbibliothek und
navigieren Sie zum Kdiinstler, Album und zu den
Track-Titeln, die Sie fur lhre Aufnahme
eingegeben haben.

Um die zuletzt hinzugefiigten Songs Ihrer
iTunes Bibliothek anzuzeigen, klicken Sie auf
das Meni Ansicht, wahlen Als Liste und klicken
dann mit der rechten Maustaste (Mac: "Strg" +
Klick) auf die Namens-Kategorie oberhalb der
Track-Liste. Im nun angezeigten Menu setzen
Sie ein Hakchen bei Hinzugefigt Am und
klicken auf OK. Oberhalb der Track-Liste
klicken Sie die Kategorie Hinzugefigt Am. |hr
neuester Song steht in der Liste nun an erster

store
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£ Recently Played
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v Tracko?
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N

Stelle. (Sie kénnen die Kategorie - Name, Kiinstler, Hinzugefligt Am etc. - jederzeit anklicken, wenn Sie die Tracks in

lhrer iTunes Bibliothek neu ordnen méchten.)

Von iTunes kénnen Sie lhre Aufnahmen auch direkt auf eine CD brennen oder auf den iPod laden.

Bitte rufen Sie das iTunes-Hilfe-Meni fur weitere Informationen zur Verwendung von iTunes auf.

Beachten Sie, dass nach dem Ubertragen von Musik auf Ihren Computer méglicherweise die Computer-
Soundkarte erneut als Wiedergabegerat ausgewéhlt werden muss. Andernfalls kann es sein, dass Sie beim
Abspielen von Audio auf Ihrem Computer keinen Ton héren kénnen. Weitere Informationen finden Sie im

Abschnitt Fehlerbehebung.
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Ich hére kein Audiosignal
bei der Aufnahme und die
Aussteuerungsanzeigen
bewegen sich nicht.

URSACHE

Keine Stromversorgung des
Gerates.

SUNG

Wenn |hr Gerét Uber eine Power-Taste verfugt, stellen Sie sicher,
dass das USB-Gerét eingeschaltet ist.

Das Gerét ist nicht am
Computer angeschlossen.

Stellen Sie sicher, dass das USB-Gerét an Ihren Computer Gber
einen funktionsfahigen USB-Port angeschlossen ist. Ist das Gerat
bereits angeschlossen, versuchen Sie, das Geréat erneut
anzuschlieBen und das Programm erneut aufzurufen.

Fehlerhaftes USB-Kabel oder
defekter USB Port.

Probieren Sie ein anderes USB-Kabel aus. Testen Sie auch einen
anderen USB-Port Ihres Computers.

Die Musik wird abgespielt
und die Lautstarkeanzeiger
bewegen sich, aber ich
hére nichts.

Der Audioausgang ist nicht
richtig eingestellt.

Uberprifen Sie bitte, dass die Soundkarte lhres Computers als
Wiedergabegerat gewahlt wurde.

Windows XP: Klicken Sie auf Startmenii » Systemsteuerung
(oder Einstellungen » Systemsteuerung in der klassischen
Ansicht) » Sound und Audiogerate. Klicken Sie auf die
Registerkarte Audio und wéhlen unter Soundwiedergabe lhre
Computer-Soundkarte als Standardgerét.

Windows Vista: Klicken Sie auf Startmenii » Systemsteuerung
(oder Einstellungen » Systemsteuerung in der klassischen
Ansicht) » Hardware und Sound » Ton. Klicken Sie auf die
Registerkarte Wiedergabe und wéhlen Sie Ihre Computer-
Soundkarte als Standardgerat.

Windows 7: Wahlen Sie Startmenii » Systemsteuerung » Ton.
Klicken Sie auf die Registerkarte Wiedergabe und wahlen Sie
lhre Computer-Soundkarte als Standardgerét.

Mac: Klicken Sie auf das obere linke "Apfel"-Symbol und klicken
dann auf Systemeinstellungen » Ton. Klicken Sie auf die
Registerkarte Ausgabe. Aus dem Meni wéhlen Sie Interne
Lautsprecher, wenn Sie die internen Computerlautsprecher
verwenden oder Kopfhdrer, wenn Sie Lautsprecher oder
Kopfhérer verwenden, die tiber den 1/8"-Kopfhérerausgang an den
Computer angeschlossen sind.

Die Computerlautsprecher
sind stumm geschaltet.

Drehen Sie die Lautstarke Ihrer Computerlautsprecher auf.

Die Computerlautsprecher
sind nicht am Computer
angeschlossen.

Sollten Sie externe Lautsprecher verwenden, tberpriifen Sie, dass
diese an der Soundkarte des Computers angeschlossen sind.

Die Soundqualitat ist
schlecht.

Die Verbindung zum
Tonabnahmesystem ist lose.

Falls Sie einen USB-Plattenspieler verwenden, muss das
Steckmodul fest an den Tonarm angeschlossen sein, wann immer
Sie den Plattenspieler benutzen.

Die Schallplatte ist verkratzt
oder schmutzig.

Bei der Aufnahme von Schallplatten, versuchen Sie, diese vor
Abspielen abzustauben und die Plattenoberfléche sanft
abzuwischen.

Andere Softwareprogramme
beeinflussen den EZ
Vinyl/Tape Converter.

SchlieBen Sie alle Programme, starten Sie den Computer und
offnen Sie nur die EZ Vinyl/Tape Converter Software zur
Aufnahme.

lhre Nadel kann beschéadigt
oder abgenutzt sein.

Nur fiir Plattenspieler: Wenn lhre Nadel alter als ein Jahr ist oder
oft verwendet wurde, kann sie beschadigt oder abgenutzt sein.
Kontaktieren Sie die ION Audio-Ersatzteilabteilung, um eine neue
Nadel zu kaufen.

Die Aufnahme klingt laut
und verzerrt.

Der Pegel ist zu hoch.

Wenn |hr USB-Gerét einen "Gain"-Regler hat, stellen Sie ihn
entsprechend ein. Sie kdnnen auch den Gain-Schieberegler in der

Die Aufnahme ist kaum
hérbar.

Der Pegel ist zu niedrig.

Software neben der Pegelanzeige einstellen (der lauteste Teil des
Songs sollte den orangen Bereich der Anzeige erreichen).

Wenn Sie selbst dann noch nicht mit Inrem Pegel zufrieden sind,
bieten die meisten Computer-Betriebssysteme einen Aufnahme-
Eingangspegelregler, den Sie anpassen kénnen:

Windows XP: (nicht verfiigbar)

Windows Vista: Klicken Sie auf Startmenii » Systemsteuerung
(oder Einstellungen » Systemsteuerung in der klassischen
Ansicht) » Hardware und Sound » Ton. Klicken Sie auf die
Registerkarte Aufnahme und wéhlen Sie "USB Audio Codec" als
Standard-Gerét aus. Klicken Sie auf Eigenschaften. Im neuen
Fenster klicken Sie auf die Registerkarte Pegel und stellen den
Schieberegler Mikrofon entsprechend ein. Wir empfehlen, den
Pegel auf "4" einzustellen.

Windows 7: Wahlen Sie Startmenii » Systemsteuerung » Ton.
Klicken Sie auf die Registerkarte Aufnahme und wéhlen Sie "USB
Audio Codec" als Standard-Gerat aus. Klicken Sie auf
Eigenschaften. Im neuen Fenster klicken Sie auf die
Registerkarte Pegel und stellen den Schieberegler Mikrofon
entsprechend ein. Wir empfehlen, den Pegel auf "4" einzustellen.
Mac: Klicken Sie auf das obere linke "Apfel"-Symbol und dann auf
Systemeinstellungen » Ton. Klicken Sie auf die Registerkarte
Eingang und stellen Sie sicher, dass lhr USB-Gerat markiert ist.
Aus dem Menl wahlen Sie lhr USB-Aufnahmegerat und passen

den Schieberegler des Eingangspegels entsprechend an.
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ROBLEM URSACHE SUNG

Uberpriifen Sie bitte, dass die Soundkarte Ihres Computers als

Ich hoére meine Aufnahmen Wiedergabegerat gewahlt wurde.

nach der Aufnahme auf Windows XP: Klicken Sie auf Startmenii » Systemsteuerung (oder
dem Computer nicht. Einstellungen » Systemsteuerung in der klassischen Ansicht)

» Sound und Audiogerite. Klicken Sie auf die Registerkarte Audio
und wéhlen unter Soundwiedergabe |hre Computer-Soundkarte als
Standardgerét.

Windows Vista: Klicken Sie auf Startmenii » Systemsteuerung
(oder Einstellungen » Systemsteuerung in der klassischen Ansicht) »

Der Audioausgang lhres Hardware und Sound » Ton. Klicken Sie auf die Registerkarte
Computers ist nicht richtig Wiedergabe und wahlen Sie Ihre Computer-Soundkarte als
Wenn der Plattenspieler eingestellt. Standardgerat.
angeschlossen ist, hére ich Windows 7: Wahlen Sie Startmenii » Systemsteuerung » Ton.
keine Musik vom Klicken Sie auf die Registerkarte Wiedergabe und wéhlen Sie lhre
Computer. Computer-Soundkarte als Standardgerat.

Mac: Klicken Sie auf das obere linke "Apfel"-Symbol und klicken dann
auf Systemeinstellungen » Ton. Klicken Sie auf die Registerkarte
Ausgabe . Aus dem Menii wahlen Sie Interne Lautsprecher, wenn
Sie die internen Computerlautsprecher verwenden oder Kopfhorer,
wenn Sie Lautsprecher oder Kopfhérer verwenden, die Gber den 1/8"-
Kopfhérerausgang an den Computer angeschlossen sind.
In Windows Vista oder Windows 7 mussen Sie méglicherweise fir den
Aufnahmeeingang den Stereo-Mode manuell auswéhlen.
- . Gehen Sie auf Start P Systemsteuerung » Sound (in der
\L,JV'?‘er Wlndoyvs VIS‘.a ealey " klassischen Ansicht). Kligken Sie dann agf den Aufn;hme Tab und
indows 7 sind meine Aufnahmeeinstellungen = N . N N N .
e stehen nicht auf “Stereo”. wahlejn Sie den Mlkroft_)n Elng_ang (USB Audio Codgc) an. Klicken Sie
anstatt in Stereo. al{f Elgen_schaften.. Kllcke_n Sie dann auf den En_/v?nert Tab und
wahlen Sie “2 Kanal, 16 Bit, 44100 Hz (CD Qualitat)” im
Standardformat Aufklappmenti aus. Driicken Sie dann auf
Ubernehmen, um die Anderung zu bestatigen.
In iTunes auf das oben links befindliche, mit iTunes bezeichnete Meni
klicken und dann Preferences wéhlen. Den im Kartenreiter General
Einstellungen in iTunes befindlichen Link Import Settings driicken und hier Import Using auf
inkorrekt. MP3 Encoder einstellen. Dann den Kartenreiter Playback klicken und
die Optionen Sound Check, Sound Enhancer und Crossfade Songs

Nach Aufnahme einer Datei
erscheint diese auf meinem
Mac als "EZACT Temp" in

iTunes und es erfolgt keine

EEERERE deaktivieren. Ist dies abgeschlossen,Dialogfenster schlieBen.
Nur fiir Plattenspieler: Wenn lhr USB-Gerat tiber einen Line-/Phono-
Schalter auf der Geréteriickseite verfligt, stellen Sie sicher, dass der
eingestellte Pegel den verwendeten Eingangen ("Line" oder "Phono")
" =M R entspricht. Wenn Ihr USB-Gerét (iber keinen derartigen Schalter
23; S;nun:namuzigzg chg?' ﬁ?iro?ucffg\zlf?srtune- verfligt, sehen Sie bitte in der Schnellstart-Anleitung nach, die mit dem
gang P . . Produkt geliefert wurde, um festzustellen, ob es sich um Line- oder
Gerats ist verzerrt oder moglicherweise nicht
- Phono-Levels handelt.
rauscht. richtig eingestellt.

Hinweis: Sie missen Ihr USB-Gerat nicht an ein Lautsprechersystem,
einen Empfénger etc. anschlieBen, um lhre Musik mit EZ Vinyl/Tape
Converter zu konvertieren. Sie missen es nur (mit einem USB-Kabel)
an lhren Computer anschlieBen.

UFIGE FRAGEN (FAQ)

Frage: Mit welchen Betriebssystemen ist EZ Vinyl/Tape Converter kompatibel?
Antwort: EZ Vinyl/Tape Converter ist derzeit kompatibel mit den Betriebssystemen Windows XP, Vista und 7 (32-Bit oder 64-Bit sowie
dem Betriebssystem Mac OS X 10.4.11 oder héher).

Frage: In welches digitale Format werden meine Aufnahmen verwandelt?

Antwort: Die Aufnahmen werden entsprechend jener Bitrate in MP3-Dateien konvertiert, die Sie in lhren iTunes Import-Einstellungen
ausgewahlt haben. Um diese Einstellungen anzusehen/zu &ndern wahlen Sie in iTunes das Menl Bearbeiten, Einstellungen, wahlen
dann die Registerkarte Allgemein und klicken auf die Schaltflache Einstellungen importieren. Klicken Sie auf das Dropdown-Menl
Import mit und wahlen Sie MP3 Encoder. Sie werden nun in der Lage sein, die gewiinschte Bitrate aus dem Dropdown-Menii
Einstellung auszuwahlen.

Frage: Wo werden die Aufnahmen auf meinem Computer abgelegt?

Antwort: Ihre Aufnahmen werden in lhrem iTunes Musikverzeichnis abgespeichert. Ab Werk ist dieses Verzeichnis beim Windows-
Betriebssystem unter My Documents » My Music » iTunes P iTunes Music zu finden, beim Mac-Betriebssystem unter Music P
iTunes P> iTunes Music, wobei die Inhalte in jedem Fall nach dem Namen des Kiinstlers geordnet sind.

Frage: Wie kann ich meine Aufnahmen auf eine CD brennen?

Antwort: Es gibt viele Méglichkeiten, lhre Aufnahmen auf eine CD zu brennen. Sie kénnen entweder iTunes oder ein anderes CD-
Brennprogramm verwenden. Um eine CD mit iTunes zu brennen, erstellen Sie eine neue Playlist und ziehen dann die Songs aus lhrer
normalen Bibliothek in diese Wiedergabeliste. Wenn Sie alle gewtinschten Titel hinzugefiigt haben, klicken Sie auf die Wiedergabeliste und
dann auf die Taste CD Brennen. Lesen Sie weitere Informationen bitte im Hilfsmeni von iTunes oder des von lhnen gewahiten
Programms.

Frage: Kann ich meiner Musik wahrend der Aufnahme zuhoren?

Antwort: Jawohl, der EZ Vinyl/Tape Converter (iberwacht die Uber Ihren Computer eingehenden Audiosignale automatisch wéhrend der
Ubertragung. Falls Sie mehrere Tongerate benutzen, empfehlen wir Ihnen, jene Gerate zu deaktivieren, die Sie nicht zur
Uberwachung verwenden méchten. Bei den meisten Anwendern besteht hier jedoch kein Problem .
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Welkom bij EZ Vinyl/Tape Converter — de meest makkelijke manier om uw opnamen over te zetten naar uw
PC. Deze software werkt naadloos samen met iTunes®, waardoor u uw opnamen naar CD kunt branden of ze
over kunt zetten naar uw draagbare digitale media-apparaat. We hopen dat u net zo zult genieten van het
gebruik van dit product als wij deden bij het voor u ontwerpen.

SOFTWARE-INSTALLATIE - PC

Plaats de bijgeleverde CD in het CD-station van uw PC.

Er hoort automatisch een pop-upscherm te verschijnen. Selecteer uw taal.

Klik op knop EZ VINYL/TAPE CONVERTER om het installatieproces te starten.

Volg de instructies op het scherm voor installatie van EZ Vinyl/Tape Converter.

Na succesvolle installatie van EZ Vinyl/Tape Converter klikt u op knop iTunes om iTunes te installeren.
Let op: EZ Vinyl/Tape Converter gebruikt iTunes om uw opnames om te zetten op uw computer.
iTunes moet op uw computer geinstalleerd zijn voor de EZ Vinyl/Tape Converter Software wordt
opgestart.

Volg de instructies op het scherm voor installatie van iTunes

Na afronding van de installatie van iTunes klikt u op knop EXIT om af te sluiten.

8.  EZ Vinyl/Tape Converter en iTunes zijn nu met succes op uw PC geinstalleerd!

SOFTWARE-INSTALLATIE - MAC

1. Plaats de bijgeleverde CD in het CD-station van uw PC.

apOD =

No

2. Open de inhoud van de CD en dubbelklik op bestand EZ Vinyl Tape Converter.Installer.pkg om het
installatieproces te starten.

3.  Volg de instructies op het scherm voor installatie van EZ Vinyl/Tape Converter.

4. Na afronding van het installatieproces kunt u de toepassing EZ Vinyl/Tape Converter vinden in de map

Toepassingen.
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UW MUZIEK OVERBRENGEN NAAR UW PC

Na installatie van de software kunt u beginnen met opnemen. Open EZ Vinyl/Tape Converter door te gaan naar Start » Alle
programma's P EZ Vinyl Tape Converter (PC) of via menu Toepassingen (Mac).

STAP 1

Na het starten van de software ziet u het scherm zoals hier rechts

weergegeven. X
Sluit het USB-apparaat met een USB-kabel aan op een beschikbare
USB-poort op uw PC. (Dit is de enige audio-aansluiting die u moet
maken om uw vinylplaten of cassettes om te zetten met deze software.)
Na aansluiting van het USB-apparaat klikt u op Next.

N.B.: Als u gevraagd wordt om uw afspeelapparaat te selecteren

(Draaitafel of Cassette recorder), selecteer dan het betreffende vakje

en klik op Volgende. Bij selectie van Cassetterecorder wordt gevraagd

het soort tape te selecteren, Normaal of Chroom. (Normale tapes .
worden het meest gebruikt, inclusief gekochte en thuis opgenomen

cassettes.)

Opmerking: Als er een boodschap verschijnt dat EZ Vinyl/Tape Converter uw USB-apparaat niet kan initialiseren, ontkoppel
dan alle andere USB-audioapparaten (USB-luidsprekers, USB-geluidskaarten, enz.) van uw computer en klik daarna nogmaals
op Volgende.

EZ Vinyl/Tape Converter

STAP 2

U ziet het scherm zoals hier rechts weergegeven.

Lokaliseer het begin van de sectie die u wilt opnemen. Het wordt
aanbevolen de niveaus voor aanvang van het opnemen te controleren.

Als uw USB-apparaat is uitgerust met een “gain”-knop, pas hem dan o
aan indien nodig. U kunt ook de gain-schuifknop in de software naast de
volumemeter aanpassen (het luidste deel van het nummer moet het
oranje deel van de meter bereiken).
Als u nog steeds ontevreden bent met het gain-niveau, zelfs na het
aanpassen van de schuifknop in de software, voorzien de meeste
besturingssystemen van computers een schuifknop voor het
ingangsniveau die u kunt aanpassen:
Windows XP: (niet beschikbaar)
Windows Vista: Klik op Start » Bedieningspaneel (of Instellingen » Bedieningspaneel in Klassieke weergave) »
Hardware en geluid » Geluid. Klik op het tabblad Opnemen en selecteer “USB Audiocodec” als standaardapparaat.
Klik op Kenmerken: Klik in het nieuwe venster op het tabblad Niveaus en pas de schuifknop Microfoon aan. Wij raden
aan het niveau in te stellen op “4”.
Windows 7: Klik op Start » Bedieningspaneel » Geluid. Klik op het tabblad Opnemen en selecteer “USB
Audiocodec” als standaardapparaat. Klik op Kenmerken: Klik in het nieuwe venster op het tabblad Niveaus en pas de
schuifknop Microfoon aan. Wij raden aan het niveau in te stellen op “4”.
Mac: Klik op het “Apple™-pictogram in de linkerbovenhoek en klik op Systeemvoorkeuren » Geluid. Klik op het tabblad
Invoer en zorg ervoor dat uw USB-apparaat is gemarkeerd. Selecteer in het menu uw USB-opname-apparaat en pas de
schuifknop Ingangsvolume naar behoren aan.
De software splitst automatisch nummers bij het detecteren van stilte in de muziek. Voor het beste resultaat: zorg ervoor dat uw
volumeniveaus tijdens de luidste delen van de song het oranje deel van de volumemeter van de software bereiken. Als uw
volume te laag is, kan EZ Vinyl/Tape Converter moeite hebben met het detecteren van het verschil tussen geluid en stilte. Om
de nummers handmatig te splitsen moet u het vakje “Automatisch opnames in afzonderlijke nummers splitsen” of het vakje
“Opname in nummers splitsen” uitvinken (aanvinken is aanbevolen voor typische popmuziek, maar kan voor wisselende
resultaten zorgen met andere genres als klassiek, gesproken tekst, enz.)
Als u klaar bent om de opname te starten, klik dan op Opnemen en start tegelijkertijd het afspelen van uw muziek (druk op
“spelen”, plaats de naald op de plaat, enz.).

Terug Opnemen

STAP 3

U bent nu aan het opnemen. U zou het geluid van het apparaat moeten

horen via de boxen van uw PC; de geluidsmeters moeten bewegen. X
Als gekozen is voor handmatige scheiding van de opname in nummers,
is een knop "New Track" (nieuw nummer) zichtbaar. U kunt deze knop
gebruiken om het begin van een nieuw nummer aan te geven.

Als u klaar bent met opnemen klikt u op Next om door te gaan naar de
volgende stap. nummer opname: Automatic

opnametijd: 000003

Volgende
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STAP 4

Na het opnemen kunt u de artiest, het album en de titels van de
opgenomen nummers invullen door te klikken in de
corresponderende velden en hierin te typen.

N.B.: Als u meer dan 10 nummers opgenomen hebt, komt u na het
klikken op Next bij de informatie voor nummers 11-20.

Als u klaar bent met het labelen van uw opnamen klikt u op Next.

De software zal uw opnamen nu exporteren naar iTunes. Geef het
exportproces tijd voor afronding.

STAP 5

Nadat de software klaar is met het exporteren van uw opnamen
naar iTunes, ziet u het scherm zoals rechts weergegeven.

Kies Yes wanneer u nog meer wilt opnemen.
Kies No wanneer u niet meer wilt opnemen.

Nadat u uw selectie heeft gemaakt klikt u op Next om verder te
gaan met opnemen (stappen 2-6) of sluit de toepassing af.

STAP 6

Nummer: [+

Artiest: ||

Album:

Titel numm

Torwg Volgende

Wacht terwijl EZ Audio Converter uw nummers exporteert

naariTunas.

Volgende

U hebt nu toegang tot uw opnames vanuit uw
iTunes-bibliotheek. Schakel over naar uw e

Fle Edt Vew Contok Store Advanced Heh

iTunes

iTunes-venster (iTunes wordt automatisch i Ml
geopend zodra uw nummers zijn

¥ Trackor
Y Trackoz
Y Trackos

overgeplaatst.) Klik links op het tabblad Music
(Muziek) en ga naar de titels Artiest, Album en
Nummer die u voor uw opname hebt ingevoerd.

Om de nieuwste nummers weer te geven die
zijn toegevoegd aan uw iTunes-bibliotheek,
klikt u op het menu View (Weergave), kiest u
de optie As List (Als lijst) en klikt u daarna met
de rechtermuisknop (of “ctrl" + klikken op een
Mac) op de categorie Name (Naam) bovenaan
de lijst met nummers. Vink in het menu dat
verschijnt Date Added (Datum toegevoegd)
aan en klik op OK. Klik bovenaan de lijst met
nummers op de categorie Date Added (Datum
toegevoegd). Uw nieuwste nummer wordt aan
de top van de lijst toegevoegd. (U kunt klikken

op de categorie Naam, Artiest, Datum toegevoegd, enz

herordenen.)

Van iTunes kunt u zelfs uw opnames direct op cd branden of opladen op uw iPod.

£ iTunes store
< png

SHARED.

GeNIUS

PLAvLISTS

£ 90's Music

£ Casskal Music
£ Music eos.
£ My Top Rated
£ Recently Added
£ Recenty Played.

Y Track 04
Y Trackos
Y Trackos
Y Trackor
Y Trackos
Y Trackos
v Trackio

Time | Artist
247 Az o1
a8 A0z
144 Aston
a8 At 08
a2 Arios
321 05
308 Ari07
200 Arios
201 Ari0s
205 Anisti0

Abum 10

o]

1050035, 27.8 minutes, 49,6 16

& @

Raadpleeg het iTunes helpmenu voor meer informatie over het gebruik van iTunes.

. telkens u de nummers in uw iTunes-bibliotheek wilt

Opgelet: na het overbrengen van muziek naar uw computer, moet u mogelijk de geluidskaart van uw
computer opnieuw selecteren als standaard afspeelapparaat. Anders hoort u mogelijk geen geluid bij het
afspelen van audio vanaf uw computer. Raadpleeg voor meer informatie het gedeelte Problemen oplossen.
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ROBLEEMOPLOSSING

OBLEEM

Ik hoor geen geluid wanneer ik
aan het opnemen ben en ik
zie de geluidsmeters niet
bewegen.

OORZAAK

USB-apparaat heeft geen
stroom.

OPLOSSING

Als uw apparaat over een aan/uitknop beschikt, zorg er dan voor dat het
USB-apparaat is ingeschakeld.

USB-apparaat niet aangeslo-
ten op de PC.

Zorg ervoor dat het USB-apparaat is aangesloten op een werkende USB-
poort van de PC. Als het apparaat al aangesloten is, probeer het dan
opnieuw aan te sluiten en start de software opnieuw.

Slechte USB-kabel of USB-
poort.

Probeer een andere USB-kabel. Probeer het USB-apparaat aan te sluiten
op een andere USB-poort van de PC.

De muziek wordt afgespeeld
en ik zie de geluidsmeters
bewegen, maar ik hoor geen
geluid.

Geluidsuitgang is niet juist
ingesteld.

Zorg ervoor dat de geluidskaart van de PC geselecteerd is als
afspeelapparaat.

Windows XP: Klik op Start » Bedieningspaneel (of Instellingen »
Bedieningspaneel in Klassieke weergave) » Geluid en audio-apparaten.
Klik op het tabblad Geluid en selecteer onder Geluid afspelen de
geluidskaart van uw computer als standaardapparaat.

Windows Vista: Klik op Start » Bedieningspaneel (of Instellingen »
Bedieningspaneel in Klassieke weergave) » Hardware en geluid »
Geluid. Klik op het tabblad Afspelen en selecteer de geluidskaart van uw
computer als standaardapparaat.

Windows 7: Klik op Start » Bedieningspaneel » Geluid. Klik op het
tabblad Afspelen en selecteer de geluidskaart van uw computer als
standaardapparaat.

Mac: Klik op het “Apple”-pictogram in de linkerbovenhoek en klik op
Systeemvoorkeuren » Geluid. Klik op het tabblad Uitvoer. Selecteer
Interne luidsprekers in het menu als u gebruik maakt van de interne
luidsprekers van uw computer of selecteer Hoofdtelefoon als u
luidsprekers of een hoofdtelefoon gebruikt die zijn aangesloten op de 1/8”-
koptelefoonuitgang van de computer.

Volumeknop van de boxen
staat te laag.

Verhoog het volume van de boxen van de PC.

Boxen zijn niet aangesloten
op de computer.

Zorg er bij gebruik van externe boxen voor dat deze aangesloten zijn op
de geluidskaart van de PC.

De geluidskwaliteit is slecht.

Aansluiting van het element
is niet in orde.

Bij gebruik van een USB-draaitafel dient het element stevig bevestigd te
zijn aan de toonarm wanneer de draaitafel in gebruik is.

Vinyl plaat is vuil of bescha-
digd.

Probeer, bij het overzetten van platen, de plaat af te stoffen en veeg het
oppervlak voorzichtig schoon voordat de plaat afgespeeld wordit.

Andere toepassingen
hinderen EZ Vinyl/Tape
Converter.

Sluit alle toepassingen af, herstart de PC en gebruik alleen EZ Vinyl/Tape
Converter tijdens het opnemen.

Uw naald kan ze kapot of
versleten zijn.

Draaitafels alleen: als uw naald meer dan een jaar oud is of veelvuldig
wordt gebruikt, kan ze kapot of versleten zijn. Neem contact op met ION
Audio-onderdelen om een andere naald aan te schaffen.

De opname klinkt luid en
vervormd.

Het versterkingsniveau is te
hoog.

De opname is nauwelijks
hoorbaar.

Het versterkingsniveau is te
laag.

Als uw USB-apparaat is uitgerust met een “gain”-knop, pas hem dan aan
indien nodig. U kunt ook de gain-schuifknop in de software naast de
volumemeter aanpassen (het luidste deel van het nummer moet het oranje
deel van de meter bereiken).

Als u nog steeds ontevreden bent met het gain-niveau, zelfs na het
aanpassen van de schuifknop in de software, voorzien de meeste
besturingssystemen van computers een schuifknop voor het
ingangsniveau die u kunt aanpassen:

Windows XP: (niet beschikbaar)

Windows Vista: Klik op Start » Bedieningspaneel (of Instellingen »
Bedieningspaneel in Klassieke weergave) » Hardware en geluid »
Geluid. Klik op het tabblad Opnemen en selecteer “USB Audiocodec” als
standaardapparaat. Klik op Kenmerken: Klik in het nieuwe venster op het
tabblad Niveaus en pas de schuifknop Microfoon aan. Wij raden aan het
niveau in te stellen op “4”.

Windows 7: Klik op Start » Bedieningspaneel » Geluid. Klik op het
tabblad Opnemen en selecteer “USB Audiocodec” als
standaardapparaat. Klik op Kenmerken: Klik in het nieuwe venster op het
tabblad Niveaus en pas de schuifknop Microfoon aan. Wij raden aan het
niveau in te stellen op “4”.

Mac: Klik op het “Apple”-pictogram in de linkerbovenhoek en klik op
Systeemvoorkeuren » Geluid. Klik op het tabblad Invoer en zorg ervoor
dat uw USB-apparaat is gemarkeerd. Selecteer in het menu uw USB-
opname-apparaat en pas de schuifknop Ingangsvolume naar behoren
aan.
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PROBLEEM

Ik kan mijn opnamen niet
horen nadat ik ze naar de PC
heb overgezet en ze vanaf de
computer wil afspelen.

OORZAAK

Wanneer het USB-apparaat is
aangesloten kan ik niet naar
muziek op mijn PC luisteren.

Geluidsuitgang van de PC is
niet juist ingesteld.

OPLOSSING

Zorg ervoor dat de geluidskaart van de PC geselecteerd is als
afspeelapparaat.

Windows XP: Klik op Start » Bedieningspaneel (of Instellingen »
Bedieningspaneel in Klassieke weergave) » Geluid en audio-apparaten.
Klik op het tabblad Geluid en selecteer onder Geluid afspelen de
geluidskaart van uw computer als standaardapparaat.

Windows Vista: Klik op Start » Bedieningspaneel (of Instellingen »
Bedieningspaneel in Klassieke weergave) » Hardware en geluid »
Geluid. Klik op het tabblad Afspelen en selecteer de geluidskaart van uw
computer als standaardapparaat.

Windows 7: Klik op Start » Bedieningspaneel » Geluid. Klik op het
tabblad Afspelen en selecteer de geluidskaart van uw computer als
standaardapparaat.

Mac: Klik op het “Apple”-pictogram in de linkerbovenhoek en klik op
Systeemvoorkeuren » Geluid. Klik op het tabblad Uitvoer. Selecteer
Interne luidsprekers in het menu als u gebruik maakt van de interne
luidsprekers van uw computer of selecteer Hoofdtelefoon als u
luidsprekers of een hoofdtelefoon gebruikt die zijn aangesloten op de 1/8"-
koptelefoonuitgang van de computer.

Onder Windows Vista zijn mijn
opnamen mono in plaats van
stereo.

Ingangseigenschappen voor
opname onder Vista zijn niet
ingesteld op "stereo".

In Vista kan het nodig zijn handmatig "stereo" te selecteren voor opnemen.
Ga naar Start P Configuratiescherm P Geluid (in Klassieke weergave).
Klik dan op tab Opnemen en kies Microfoon-ingang (USB Audio Codec).
Klik op Eigenschappen om de ingangsinstellingen te tonen. Klik hierna op
tab d en selecteer "2 kanalen, 16 bit, 44100 Hz (CD-kwaliteit)"
in het keuzemenu Standaard opmaak. Als laatste klikt u op Toepassen
om de instellingen te bevestigen.

Op mijn Mac verschijnt een
bestand na opname in iTunes
als "EZACT Temp" en het
wordt niet afgespeeld.

De instellingen van iTunes
moeten worden aangepast.

Klik in iTunes op menu iTunes links bovenin en klik dan op Voorkeuren.
Klik op tab Algemeen, daarna op knop Instellingen importeren en stel
Importeren met in op MP3 Encoder. Klik hierna op tab Afspelen en vink
Soundcheck, Versterken geluid en Crossfaden af. Sluit het venster als
u klaar bent.

Het geluid uit de audio-
uitgangen van mijn USB-
apparaat is vervormd of vol

De schakelaar lijn/phono is
mogelijk niet goed ingesteld.

Draaitafels alleen: Als uw USB-apparaat over een lijn/phono-schakelaar
beschikt op het achterpaneel, zorg er dan voor dat deze is ingesteld op het
juiste niveau voor de ingangen waarop het is aangesloten (“lijn” of
“phono”). Als uw USB-apparaat niet over deze schakelaar beschikt,
raadpleeg dan de beknopte handleiding bij het product om te bepalen of
het lijn- of phono-niveau is.

statische ruis. Opmerking: U hoeft uw USB-apparaat niet aan te sluiten op een
luidsprekersysteem, ontvanger, enz. om met EZ Vinyl/Tape Converter uw
muziek te converteren. U hoeft het alleen maar aan te sluiten op uw

computer (met behulp van een USB-kabel).

VEELGESTELDE VRAGEN

Vraag: Met welke besturingssystemen is EZ Vinyl/Tape Converter compatibel?
Antwoord: EZ Vinyl/Tape Converter is momenteel compatibel met Windows XP, Vista, Windows 7 (32-bits of 64-bits) en het
besturingssysteem Mac OS X 10.4.11 (of hoger).

Vraag: Naar welk digitaal formaat worden mijn opnamen overgezet?

Antwoord: De opnames worden omgezet in MP3-bestanden op de bitrate die is geselecteerd in de Importeerinstellingen in
iTunes. Om deze instellingen in iTunes te bekijken/wijzigen, klikt u op het menu Bewerken, selecteert u Voorkeuren, het
tabblad Algemeen en klikt u op de knop Importeerinstellingen. Klik op het vervolgkeuzemenu Importeer via en selecteer
MP3-coderingsprogramma. U zal nu in staat zijn om de gewenste bitrate te selecteren in de vervolgkeuzelijst Instelling
eronder.

Vraag: Waar op mijn PC worden mijn opnamen opgeslagen?

Antwoord: Uw opnamen worden opgeslagen in de Muziekmap van iTunes. Deze map bevindt zich standaard in Mijn
Documenten » Mijn Muziek » iTunes » iTunes Muziek onder Windows of in Muziek » iTunes » iTunes Muziek onder
Mac OS en de inhoud wordt georganiseerd op naam van de artiest.

Vraag: Hoe brand ik mijn opnamen naar een CD?

Antwoord: Er zijn diverse manieren om uw opnamen op CD te branden. U kunt hiervoor iTunes of andere CD-brandsoftware
gebruiken. Voor het branden van een CD met behulp van iTunes, maak een nieuwe afspeellijst en sleep de nummers van uw
normale bibliotheek op deze afspeellijst. Wanneer u alle gewenste nummers hebt toegevoegd klikt u op die afspeellijst en klikt
u vervolgens op de knop Schijf branden. Raadpleeg het hulpmenu van iTunes of van het programma dat u gebruikt voor meer
informatie.

Vraag: Kan ik tijdens het opnemen luisteren naar de muziek via mijn computer ?

Antwoord: Ja, EZ Vinyl/Tape Converter zorgt tijdens de overdracht van uw muziek voor automatische monitoring via uw
computer van het binnenkomend geluidssignaal. Als u gebruik maakt van meerdere audio-apparaten, raden wij u aan alle
apparaten die u niet voor monitoring wenst te gebruiken uit te schakelen. Voor de meeste gebruikers zal dat echter geen
probleem zijn.
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JOHDANTO

Tervetuloa kayttdamaan EZ vinyylilevy/nauha -muunninta, jotka ovat helpoin tapa siirtda tallenteet
tietokoneelle. Tam& ohjelmisto toimii saumattomasti iTunesin® kanssa ja antaa sinulle mahdollisuuden
polttaa tallenteesi CD-levylle tai siirtdd ne siirrettavélle digitaaliselle tietovélineelle. Toivomme, ettd nautit
tasta tuotteesta yhta paljon, kuin me olemme nauttineet sen suunnittelustal

OHJELMISTON ASENNUS - PC

1.
2.
3.

o

6.
7.

8

Aseta mukana toimitettu CD-levy tietokoneesi CD-asemaan.

Ponnahdusikkuna aukeaa. Valitse kieli.

Napsauta EZ VINYL/TAPE CONVERTER (EZ VINYYLILEVY/NAUHA -MUUNNIN) -painiketta
aloittaaksesi asennustoiminnon.

Suorita EZ vinyylilevy/nauha -muuntimen asennus noudattamalla ndytén ohjeita.

Kun EZ vinyylilevy/nauha -muunnin on asentunut onnistuneesti, napsauta iTunes-painiketta
asentaaksesi iTunesin.

Huomaa: EZ vinyylilevy/nauha -muunnin toimii yhdesséd iTunesin kanssa muuntaakseen tallenteet
tietokoneellesi. iTunesin tulee olla asennettuna tietokoneellesi ennen EZ vinyylilevy/nauha -muuntimen
kdynnistdmista.

Suorita iTunesin asennus noudattamalla néytdn ohjeita.

Kun iTunesin asennus on suoritettu onnistuneesti, napsauta EXIT (POISTU) -painiketta lopettaaksesi.
EZ vinyylilevy/nauha -muunnin ja iTunes on asennettu tietokoneellesi onnistuneesti.

OHJELMISTON ASENNUS - MAC

1.

d

Aseta mukana toimitettu CD-levy tietokoneesi CD-asemaan.

Avaa CD-levyn siséltd ja kaksoisnapsauta EZ Vinyl Tape Converter.Installer.pkg -tiedostoa
aloittaaksesi asennustoiminnon.

Suorita EZ Vinyl/Tape -muuntimen asennus noudattamalla naytén ohjeita.

Kun asennus on suoritettu loppuun, EZ Vinyl/Tape -muunnin l6ytyy Applications (Ohjelmat) -
kansiosta.
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KIN SIIRTAMINEN TIETOKONEELLESI

Kun olet asentanut ohjelmiston, voit aloittaa tallentamisen. Avaa EZ vinyylilevy/nauha -muunnin siirtymalla Start (Kéynnisté)»
All Programs (Kaikki ohjelmat) » EZ Vinyl Tape Converter (PC:|l4) tai avaa Applications (Ohjelmat) -valikosta (Mac).

VAIHE 1

Kun kéynnistat ohjelman, néaet oikealla nakyvan naytén. X
Yhdista USB-laitteen USB-johto tietokoneen vapaaseen USB-porttiin. (Taméa

on ainoa audiolitos, joka on suoritettava vinyylilevyjen tai nauhojen |2 AL L
muuntamiseksi tdmén ohjelmiston avulla.)

Kun USB-laite on liitetty, napsauta Next (Seuraava).

Huomautus: Jos sinua kehotetaan valitsemaan toistolaite (Turntable

(Levysoitin) tai Tape (Nauha) Player (Soitin)), valitse oikea valintalaatikko

ja napsauta Next (Seuraava). Jos valitsit Tape Player (Kasettisoitin), sinua

pyydetdan valitsemaan nauhan muoto, Normal (Normaali) tai Chrome »
(Kromi). (Normaalit nauhat ovat yleisimpid, mukaan lukien kaupasta ostetut

nauhat ja kotinauhoitukset.)

Huomautus: Jos néet viestin, ettd EZ vinyylilevy/nauha -muunnin ei pysty alustamaan USB-laitetta, irrota kaikki muut USB-
audiolaitteet (USB-kaiuttimet, USB-audioliitdnnat jne.) tietokoneestasi ja napsauta tdméan jélkeen uudelleen Next (Seuraava) -
painiketta.

VAIHE 2

Néet oikealla ndkyvan naytén.
Etsi tallennettavan alueen alku. Suosittelemme, etta tarkastat tasot ennen
tallennuksen aloittamista.
Jos USB-laitteessa on gain (saanti) -ohjain, saada sité tarpeen mukaan. Voit
myds saatdd gain (saanti) -liukusdadinta aanenvoimakkuuden mittarin
vieressa (kappaleen voimakkaimman kohdan tulee saavuttaa mittarin oranssi
kohta).
Jos et ole tyytyvainen gain (saanti) -tasoon ohjelmiston gain (saanti) -
séadintd  kaytettyasi, useissa tietokoneiden kayttdjarjestelmissa on o
tallennuksen tulotason séaadin, jota voit sdataa:
Windows XP: (ei saatavilla)
Windows Vista Napsauta Start Menu (Kaynnista-valikko)» Control Panel (Ohjauspaneeli) (tai Settings
(Asetukset) » Control Panel (Ohjauspaneeli) Classic View (Perinteinen nakyma)) » Hardware and Sound (Laitteisto ja
aani)» Sound (Adni). Napsauta Recording (Tallennus) -vélilehtea ja valitse "USB Audio Codec (USB-aénen
pakkaus)" oletuslaitteeksi. Napsauta Properties (Ominaisuudet). Napsauta uudessa ikkunassa Levels (Tasot) -
vélilehtea ja saada Microphone (Mikrofoni) -sdadinté tarpeen mukaan. Suosittelemme asettamaan tasoksi 4.
Windows 7: Napsauta Start Menu (Kaynnista-valikko)» Control Panel (Ohjauspaneeli) » Sound (Aani). Napsauta
Recording (Tallennus) -vélilehtea ja valitse "USB Audio Codec (USB-dénen pakkaus)" oletuslaitteeksi. Napsauta
Properties (Ominaisuudet). Napsauta uudessa ikkunassa Levels (Tasot) -vélilehted ja sdad& Microphone
(Mikrofoni) -saadinté tarpeen mukaan. Suosittelemme asettamaan tasoksi 4.
Mac: Napsauta vasemman ylédkulman apple-kuvaketta ja napsauta tdmén jalkeen System Preferences (Jérjestelmén
ominaisuudet) » Sound (A&ni). Napsauta Input (Tulo) -valilehted ja varmistu, ettd USB-laite on korostettuna. Valitse
valikosta USB-tallennuslaite ja sdadé Input Volume (Tulon déanenvoimakkuus) -saédinta tarpeen mukaan.
Ohjelmisto jakaa kappaleet automaattisesti, kun se havaitsee musiikissa tauon. Varmistu, ettd &anenvoimakkuuden taso
saavuttaa ohjelmiston &anenvoimakkuuden mittarin oranssin tason kappaleiden &anekkaimmissd osissa parhaimman
lopputuloksen saamiseksi. Jos &&nenvoimakkuus on liian alhainen, EZ vinyylilevy/nauha -muuntimella saattaa olla vaikeuksia
aanen ja tauon erottamisessa. Leikkaa kappaleet manuaalisesti poistamalla valinta kohdasta Automatically split recording into
separate tracks (Jaa tallenne automaattisesti kappaleisiin) tai Split recording into tracks (Jaa tallenne kappaleisiin). (Tata
suositellaan tavalliselle pop-musiikille, mutta se saattaa antaa vaihtelevia tuloksia, kun sitd kaytetdan muiden lajityyppien, kuten
klassisen musiikin, puheen jne. kanssa)
Kun olet valmis aloittamaan tallentamisen, napsauta Record (Tallenna) ja aloita vélittdmasti musiikin soittaminen (paina play
(toista), aseta neula levyn péaalle jne.).

VAIHE 3

Tallennus on aloitettu. Sinun tulisi kuulla laitteesta tuleva &ani tietokoneen
kaiuttimista ja néhda aanimittareiden liikkuvan. Jos et kuule musiikkia,
varmista, ettd tietokoneesi &anenvoimakkuus ei ole mykistettyna. (Jos et
vieldk&an kuule musiikkia, katso taman ohjekirjan Vianmaaritys-luku.)

Jos valitsit, ettd kappaleet jaetaan manuaalisesti, ndet New Track (Uusi
kappale) -painikkeen. Voit kayttda tatd painiketta uuden kappaleen alun
merkitsemiseen.

Kun olet lopettanut tallentamisen, napsauta Next (Seuraava) -painiketta
siirtyaksesi seuraavaan vaiheeseen. »

recording time: 000025

recording track:  Automatic
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VAIHE 4

Kun olet lopettanut tallentamisen, kirjoita Artist (Esittaja), Album
(Albumi) ja Track title (Kappaleen otsikko) napsauttamalla ja
kirjoittamalla vastaaviin kenttiin. (Jos tallennat eri esittdjia ja
albumeita, ne on ehka tallennettava erillisissa osissa.)
Huomautus: Jos olet tallentanut enemmén kuin 10 kappaletta,
voit ndhdd kappaleiden 11-20 tiedot napsauttamalla Next
(Seuraava) -painiketta.

Kun olet lopettanut tallenteen merkitsemisen, napsauta Next
(Seuraava).

Ohjelmisto  siirtda tallenteet iTunesiin. Odota vientitoiminnon

paattymista.

VAIHE 5

Kun ohjelmisto on vienyt tallenteesi iTunesiin, naet oikealla olevan
nayton.

Valitse Yes (Kylld), jos haluat tallentaa uudelleen.

Valitse No (Ei), jos et halua tallentaa lisaa.

Kun olet tehnyt valintasi, napsauta Next (Seuraava)-painiketta
tallentaaksesi uudelleen tai poistuaksesi ohjelmasta.

VAIHE 6

Track: [1

Artist

Album:

Track title:

\'/
/|\

1an

Nyt voit kéyttaa tallenteitasi iTunes-kirjaston kautta.
Siirry iTunes-ikkunaan (iTunes avautuu e

iTunes

ST

automaattisesti, kun kappaleet on viety.) Napsauta
kirjaston Music (Musiikki) -valilehted vasemmalla
ja siirry esitt: n, albumiin tai kappaleen nimeen, £

jonka maérittelit tallenteellesi. £l Tiws e
Nahdaksesi uusimman iTunes-kirjastoon lisatyn | suw

kappaleen napsauta View (Néyta) -valikkoa, valitse ~|=**

As List (Luettelo) ja napsauta tdman jélkeen (tai © moss0)
ctri+napsauta Mac-tietokoneella) Name (Nimi) -
luokkaa kappaleiden luettelon ylépuolella. Valitse
avautuvasta valikosta Date Added
(Lisdyspaivamaard) ja napsauta OK. Napsauta
kappaleiden luettelon ylapuolella Date Added
(Liséyspaivamaara) -luokkaa. Uusin kappale on
luettelon alussa. (Voit jarjestdd iTunes-kirjaston
kappaleet milloin tahansa uudelleen napsauttamalla

£ s vdeos
25wy TopRazed

£ Recontly adced
£ Recently Flsyed

=2 ez vinylTape Corveter ..
2 Trads

205 10

Name (Nimi)-, Artist (Esittaja)-,

Date Added L#®==m@

10s0ngs, 278 mirutes, 49,618

(Lisayspaivaméaara) -luokkia)

Voit polttaa tallenteesi iTunesista suoraan CD-levylle tai ladata ne iPodille.

Katso lisatietoja iTunesin kayttamisesta iTunesin ohjevalikosta.
Huomaa, ettd musiikin siirta 1 jélkeen tietokor

i, sinun on ehkéd valittava tietokoneesi &dénikortti

uudelleen toistolaitteeksi. Muussa tapauksessa et ehkd kuule dédntd, kun toistat dédnta tietokoneellasi. Katso

lisétietoja kohdasta Vianmdéaritys.
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VIANMAARITY!

ONGELMA

En kuule mitaén &éanta
hoittaessani enka nae
nimittareiden liikkuvan.

SYY

USB-laite ei ole paalla.

RATKAIS

Jos laitteessasi on virtapainike, varmistu, etta USB-laite on paalla.

USB-laite ei ole liitettyna
tietokoneeseen.

Varmistu, ettd USB-laite on liitettyna toimivaan tietokoneesi USB-
porttiin. Jos se on jo liitettynd, yrité liittaa laite uudelleen ja kaynnistaa
ohjelmisto uudelleen.

Viallinen USB-johto tai USB-portti.

Kokeile kéyttaa toista USB-johtoa. Yritd myds yhdistad USB-laite
tietokoneesi toiseen USB-porttiin.

Musiikkia toistetaan ja naen, etta
aanimittarit likkuvat, mutta en
kuule &anta.

Adnen 1aht? ei ole asetettu oikein.

Varmistu, etté tietokoneesi ikortti on valittu toistolaitteeksi.
Windows XP: Napsauta Start Menu (Kéynnisté-valikko) » Control
Panel (Ohjauspaneeli) (tai Settings (Asetukset) » Control Panel
(Ohjauspaneeli) Classic View (Perinteinen nékymé)) » Sound and
Audio Devices (£ itteet). Napsauta Audio (A&ni) -valilehtea ja
valitse Sound playback (Agnen toisto) -kohdan alta tietokoneesi
aanikortti oletuslaitteeksi.

Windows Vista: Napsauta Start Menu (Kaynnista-valikko) » Control
Panel (Ohjauspaneeli) (tai Settings (Asetukset) » Control Panel
(Ohjauspaneeli) Classic View (Perinteinen nakyma)) » Hardware and
Sound (Laitteisto ja 4ani)» Sound (Aa Napsauta Playback
(Toisto) -valilehtea ja valitse tietokoneesi aanikortti oletuslaitteeksi.
Windows 7: Napsauta Start Menu (K&dynnista-valikko) » Control
Panel (Ohjauspaneeli) » Sound (; i). Napsauta Playback (Toisto)
-valilehted ja valitse tietokoneesi &anikortti oletuslaitteeksi.

Mac: Napsauta vasemman ylakulman apple-kuvaketta ja napsauta
taman jalkeen System Preferences (Jarjestelman ominaisuudet) »
Sound (Azni). Napsauta Output (Lahts) -valilehtea. Valitse valikosta
Internal Speakers (Sisaiset kaiuttimet), jos kaytat tietokoneesi

tietokoneen 1/8"-kuulokeliitantaén liitettyja kaiuttimia tai kuulokkeita.

Tietokoneen kaiuttimet on
mykistetty.

Sé&ada tietokoneesi kaiuttimien dénenvoimakkuutta ylos.

Tietokoneen kaiuttimia ei ole
liitetty.

Jos kaytat ulkoisia kaiuttimia, varmistu, etta ne on liitetty tietokoneesi
aanikorttiin.

Aanenlaatu on huono.

Aanirasian liitos on huono.

Jos kaytat USB-levysoitinta, &anirasian on oltava tiukasti liitettyna
aanivarteen levysoitinta kaytettaessa.

Vinyylilevy on likainen tai siind on
naarmuja.

Jos siirrat vinyylilevylta, yritd pyyhkia levyn pinta kevyesti ennen sen
soittamista.

Muut sovellukset héiritsevat EZ
vinyylilevy/nauha/aéni -
muunninta.

Sulje kaikki sovellukset, kdynnisté tietokone uudelleen ja suorita
ainoastaan EZ vinyyli/nauha/aani-muunnin tallennuksen aikana.

Levysoittimen neula saattaa olla
kulunut.

Ainoastaan levysoittimet: Jos levysoittimen neula on yli vuoden
vanha tai sitd on kaytetty runsaasti, se saattaa olla rikkoutunut tai
kulunut. Ota yhteytta IONin &éniosien osastoon hankkiaksesi uuden
levysoittimen neulan.

Tallenteen &&nenvoimakkuus on
suuri ja &ani on epaselva.

Gain (saanti) -taso on liian suuri.

Tallenne kuuluu heikosti.

Gain (saanti) -taso on liian
alhainen.

Jos USB-laitteessa on gain (saanti) -ohjain, sdada sita tarpeen
mukaan. Voit myds séétaa gain (saanti) -liukusaadinta
aanenvoimakkuuden mittarin vieressa (kappaleen voimakkaimman
kohdan tulee saavuttaa mittarin oranssi kohta).

Useimmissa kayttojarjestelmissé on sdadettava tallennuksen tulotason
saadin:

Windows XP: (ei saatavilla)

Windows Vista: Napsauta Start Menu (Kaynnista-valikko) » Control
Panel (Ohjauspaneeli) (tai Settings (Asetukset) » Control Panel
(Ohjauspaneeli) Classic View (Perinteinen nakyma)) » Hardware and
Sound (Laitteisto ja d4ni)» Sound (Azni). Napsauta Recording
(Tallennus) -vélilehtea ja valitse "USB Audio Codec (USB-dénen
pakkaus)" oletuslaitteeksi. Napsauta Properties (Ominaisuudet).
Napsauta uudessa ikkunassa Levels (Tasot) -vélilehtea ja saada
Microphone (Mikrofoni) -saadinta tarpeen mukaan. Suosittelemme
asettamaan tasoksi 4.

Windows 7: Napsauta Start Menu (Kaynnisté-valikko) » Control
Panel (Ohjauspaneeli) » Sound (Aini). Napsauta Recording
(Tallennus) -vélilehtea ja valitse "USB Audio Codec (USB-aénen
pakkaus)" oletuslaitteeksi. Napsauta Properties (Ominaisuudet).
Napsauta uudessa ikkunassa Levels (Tasot) -vélilehtea ja saada
Microphone (Mikrofoni) -saadinta tarpeen mukaan. Suosittelemme
asettamaan tasoksi 4.

Mac: Napsauta vasemman ylakulman apple-kuvaketta ja napsauta
taman jalkeen System Preferences (Jarjestelman ominaisuudet) »
Sound (Azni). Napsauta Input (Tulo)-valilehtea. Valitse valikosta
USB-tallennuslaite ja séada Input Volume (Tulon &&nenvoimakkuus)
-séadinta tarpeen mukaan.
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ONGELMA

En kuule tallenteita, kun olen
siirtényt ne ja yritan toistaa niita
tietokoneellani.

En voi kuunnella mitdén musiikkia
tietokoneeltani, kun USB-laite on
liitettyna.

SYY

Tietokoneen &anen lahto ei ole
asetettu oikein.

RATKAIS
Varmistu, etta tietokoneesi aanikortti on valittuna toistolaitteeksi.

Windows XP: Napsauta Start Menu (Kéynnista-valikko) » Control
Panel (Ohjauspaneeli) (tai Settings (Asetukset) » Control Panel
(Ohjauspaneeli) Classic View (Perinteinen ndkymd)) » Sound and
Audio Devices (Aanllameet) Napsauta Audio (Aéni) -valilehtea ja
valitse Sound playback (Aénen toisto) -kohdan alta tietokoneesi
aanikortti oletuslaitteeksi.

Windows Vista: Napsauta Start Menu (Kéynnisté-valikko) » Control
Panel (Ohjauspaneeli) (tai Settings (Asetukset) » Control Panel
(Ohjauspaneeli) Classic View (Perinteinen ndkyma)) » Hardware and
Sound (Laitteisto ja i)> Sound (A#ni). Napsauta Playback
(Toisto) -vélilehtea ja valitse tietokoneesi aanikortti oletuslaitteeksi.
Windows 7: Napsauta Start Menu (Kéynnisté-valikko) » Control
Panel (Ohjauspaneeli) » Sound (Azni). Napsauta Playback (Toisto)
-valilehtea ja valitse tietokoneesi danikortti oletuslaitteeksi.

Mac: Napsauta vasemman ylakulman apple kuvakena ja napsauta
taman jalkeen System P (Jé

Sound (A&ni). Napsauta Output (Léh dlilehted. Valitse vallkosla
Internal Speakers (Sisaiset kaiuttimet), jos kaytat tietokoneesi
sisaisia kaiuttimia tai valitse Line Output (Linjalahto), jos kaytat
kaiuttimia tai valitse Headphones (Kuulokkeet), jos kaytat 1/8"-

Windows Vista- ja Windows 7 -
tietokoneella tallenteeni ovat
mono-muodossa stereo-muodon
sijaan.

Tallennuksen syétto-ominaisuutta
ei ole asetettu stereoksi.

Sinun on ehka asetettava manuaalisesti stereo-asetus tallennuksen
syotto-asetukseksi.

Valitse Start (Kdynnisté) P Control Panel (Ohjauspaneeli)®» Sound
(Aani) (perinteisessa nakymassa). Napsauta taman jalkeen Recording
(Tallennus) -valilehtea ja korosta Microphone (Mikrofoni) -input
(sy6tto) (USB-aanen pakkaus). Napsauta Properties (Ominaisuudet)
avataksesi syottoasetukset. Napsauta seuraavaksi Advanced
(Liséasetukset) -vélilehted ja valitse 2 channel (kanavaa), 16 bit
(bittia), 44100 Hz CD quality (CD-laatu) Default Format

(ol -pudott lik . Napsauta lopuksi Apply (Kayta)
hyvéksyaksesi asetukset.

Mac-tietokoneellani tallennettu
tiedosto nékyy nimella "EZACT
Temp" iTunesissa ja sita ei voi
toistaa.

iTunesin asetuksia on
muutettava.

Napsaula iTunesissa iTunes-valikkoa vasemmalla ylhaalla ja napsauta
A ). Napsauta (Yleiset) -vélilehted,
Import Settings (Tuontiasetukset) -painiketta ja aseta Import Using
(Tuo kayttamalld) asetukseksi MP3 Encoder (MP3-kooderi).
Napsauta tdmén jalkeen Playback (Toisto) -vélilehted ja poista valinta
kohdista Sound Check Sound (Adnen
tehostin) ja Crossfade Songs (Haivyta kappaleet). Sulje ikkuna

USB-laitteeni &anilahté on

Line/phono-tason kytkinta ei ole
ehka asetettu oikein.

lopuksi.
i

levysoitti Jos USB: on line/phono-kytkin
takapaneelissa, varmistu, etta se on asetettu oikealle tasolle syGtaille,
joihin se on liitetty (line tai phono). Jos USB-laitteessasi ei ole tata
kytkinta, katso tuotteen mukana toimitetusta pikaohjeesta
maéadritellaksesi onko se line- vai phono-taso.

epé elva tai siin& on staattisia
héi b

Huomautus: Sinun ei tarvitse liittad USB-laitettasi kaiutinjarjestelmaan,
vastaanottimeen jne. muuntaaksesi musiikkia EZ Vinyl/Tape Converter
-muuntimella. Se taytyy ainoastaan liittaa tietokoneeseen (USB-

johdolla).

SEIN ESITETYT SET

Kysymys: Minké kayttojarjestelmien kanssa EZ Vinyl/Tape Converter -muunnin on yhteensopiva?
Vastaus: EZ Vinyl/Tape Converter on télla hetkella yhteensopiva Windows XP -, Vista- ja 7 -kayttéjarjestelmien kanssa (32- tai
64-bittinen seka Mac OS X 10.4.11 -kayttojarjestelma (tai uudempi).

Kysymys: Mihin digitaalisiin muotoihin tallenteeni muutetaan?

Vastaus: Tallenteet muunnetaan  MP3-tiedostoiksi  iTunesin  tuontiasetuksissa = maaritetylld  bittinopeudella.
Muuttaaksesi/katsoaksesi naitd asetuksia iTunesissa napsauta Edit (Muokkaa) -valikkoa, valitse Preferences (Asetukset),
valitse General (Yleiset) -valilehti ja napsauta Import Settings (Tuontiasetukset) -painiketta. Napsauta Import Using (Tuo
kéyttamalla) -pudotusvalikkoa ja valitse MP3 Encoder (MP3-kooderi). Voit valita halutun bittinopeuden tamén alapuolella
olevasta Setting (Asetus) -pudotusvalikosta.

Kysymys: Mihin tallenteet tallennetaan tietokoneellani?

Vastaus: Tallenteesi talletetaan iTunesin musiikkikansioon. Oletuksena tamé kansio sijaitsee Windows-kayttojarjestelmassa
My Documents (Omat asiakirjat)» My Music (Oma musiikki)» iTunes P iTunes Music (iTunes musiikki) -kansiossa tai
Mac-kayttojarjestelmassa Music (Musiikki) B> iTunes P> iTunes Music (iTunes-musiikki) -kansiossa ja siséltdé on jarjestetty
esittdjan nimen mukaan.

Kysymys: Kuinka voin polttaa tallenteet CD-levylle?

Vastaus: Tallenteet voidaan polttaa CD-levylle useilla eri tavoilla. Voit kayttaa iTunesia tai jotakin muuta CD-levyjen poltto-
ohjelmaa. Polta CD-levy iTunesilla luomalla uusi Playlist (Soittolista), ja veda kappaleet kirjastosta tahén soittolistaan. Kun olet
lisannyt kaikki haluamasi kappaleet, napsauta kyseistd soittolistaa ja napsauta tdmén jalkeen Burn Disc (Polta levy) -
painiketta. Katso lisatietoa iTunesin (tai kayttamasi sovelluksen) ohjevalikosta.

Kysymys: Voinko kuunnella musiikkia tietokoneeltani tallentamisen aikana?

Vastaus:Kylla, EZ Vinyl/Tape Converter -muunnin valvoo automaattisesti tietokoneen l&pi kulkevaa aantd, kun musiikkia

siirretdan. Jos kaytdt useampia &aanilaitteita, on suositeltavaa ottaa pois kaytosta kaikki laitteet, joita et halua kayttaa
valvontaan. Suurimmalle osalle kéyttéjista tdmé ei ole kuitenkaan ongelmallista.
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INTRODUKTION

Valkommen till EZ Vinyl/Tape Converter — det enklaste sattet att 6verféra dina inspelningar till din dator pa.
Denna programvara fungerar smidigt med iTunes® och gér det méjligt att du kan bréanna dina inspelningar pa
en CD eller dverféra dem till en portabel digital mediaenhet. Vi hoppas du kommer att gilla att anvénda
denna produkt lika mycket som vi gillade att designa den at dig!

PROGRAMVARUINSTALLATION - PC

1. Sattin den medféljande CD:n i din dators CD-enhet.

2.  Ett pop-up-fonster bor visas automatiskt. Valj ditt sprak.

3.  Klicka pa knappen EZ VINYL/TAPE CONVERTER for att starta installationsprocessen.

4.  Folj instruktionerna pa skarmen for att installera EZ Vinyl/Tape Converter.

5.  Nar EZ Vinyl/Tape Converter har installerats, klicka p& iTunes-knappen for att installera iTunes.
Observera: EZ Vinyl/Tape Converter fungerar tillsammans med iTunes fér att konvertera dina
inspelningar till din dator. iTunes maste vara installerat pa din dator innan programvaran EZ Vinyl/Tape
Converter startas.

6.  Folj instruktionerna pa skarmen for att intallera iTunes.

7. Narinstallationen av iTunes har slutforts, klicka pa knappen EXIT (Avsluta) for att avsluta.

8. EZ Vinyl/Tape Converter och iTunes har nu installerats pa din dator!

PROGRAMVARUINSTALLATION - MAC

1. Séatt in den medféljande CD:n i din dators CD-enhet.

Oppna CD:ns innehall och dubbelklicka pa filen EZ Vinyl Tape Converter.Installer.pkg for att starta
installationsprocessen.

Folj instruktionerna pa skarmen for att installera EZ Vinyl/Tape Converter.

Nar installationsprocessen har avslutats, kan du hitta EZ Vinyl/Tape Converter-programmet i din
Applications-mapp (Programmapp).

Eall o
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OVERFOR MUSIK TILL DIN DATOR

Nar du har installerat programvaran kan du bérja spela in. Oppna EZ Vinyl/Tape Converter genom att ga till Start » All
Programs (Alla program) P EZ Vinyl Tape Converter (PC), eller till Applications-menyn (Programmenyn) (Mac).

STEG 1

Né&r du har startat programvaran ser du skdrmen som visas till hdger.

Anslut en USB-kabel fran USB-enheten till en tillganglig USB-port i =
datorn. (Detta &r den enda ljudanslutning som du behdver for att
konvertera dina vinylskivor och kassetter med programvaran.)

Néar USB-enheten ar ansluten, klicka pa Next (Nasta).

Obs: Om du ombeds att vélja din uppspelningsenhet (Turntable
(skivspelare) eller Tape Player (kassettbandspelare), markera lamplig
ruta och klicka pa Next (Nasta). Om du valde Tape Player ombeds du
att valja kassettbandsformat, Normal eller Chrome (krom).
(Kassettbandsformatet Normal ar vanligast, inklusive fabrikstillverkade »

och kassettband fér heminspelning.) e
Obs: Om du ser ett meddelande dar det star att EZ Vinyl/Tape

Converter inte kan initiera din USB-enhet, koppla da ifran alla andra USB-ljudenheter (USB-hégtalare, USB-ljudgranssnitt etc.)
fran datorn och klicka sedan pa Next (Nasta) igen.

STEG 2

EZ Vinyl/Tape Converter

Nu ser du skdrmen som visas till héger.

Lokalisera bérjan av sparet som du vill spela in. Vi rekommenderar att

du kontrollerar nivaerna innan du bérjar inspelningen.

Om din USB-enhet &r utrustad med en "férstarkar'-kontroll (gain),

justera den enligt behov. Du kan &ven anvéanda forstéarkar-reglaget i

programvaran bredvid volymnivdméataren (den del av laten med den

hogsta volymen boér n& den orangefargade delen pa métaren). e

Om du fortfarande ar missnéjd med forstarkamivan efter att du har

justerat programvarans forstarkar-reglage, s& kan du justera

inspelningsing&ngens nivareglage, vilket de flesta OS-system har:
Windows XP: (ej tillgangligt) L
Windows Vista: Klicka pa Start Menu (Startmeny) » Control
Panel (Kontrollpanel) (eller Settings (Instaliningar) » Control Panel in Classic View (Kontrollpanel i klassisk vy)) »
Hardware and Sound (Hardvara och ljud) » Sound (Ljud). Klicka pa fliken Recording (Inspelning) och vélj "USB
Audio Codec" (USB-ljudcodec) som standardenhet. Klicka pa Properties (Egenskaper). | det nya fonstret som visas,
klicka pa fliken Levels (Nivaer) och justera Mikrofon-reglaget till lamplig niva. Vi rekommenderar att du stéller in nivan
till "4".
Windows 7: Klicka pa Start Menu (Startmeny) » Control Panel (Kontrollpanel) » Sound (Ljud). Klicka pa fliken
Recording (Inspelning) och valj "USB Audio Codec" (USB-ljudcodec) som standardenhet. Klicka pa Properties
(Egenskaper). | det nya fonstret som visas, klicka pa fliken Levels (Nivaer) och justera Mikrofon-reglaget till Iamplig
niva. Vi rekommenderar att du staller in nivan till "4".
Mac: Klicka pa "apple"-ikonen i det 6vre vanstra hornet och klicka sedan pa System Preferences (Systempreferenser)
» Sound (Ljud). Klicka pa fliken Input (Ingang) och se till att din USB-enhet &r markerad. Valj din USB-
inspelningsenhet fran menyn och justera Input Volume-reglaget (Ingangsvolymen).

Programvaran delar upp sparen automatiskt nér den hittar tysta delar i laten. For basta resultat, se till att dina volymnivaer nar

den orangefargade delen pa programvarans volymmatare under den del av laten som har den hdgsta volymen. Om volymen &r

for lag, kan EZ Vinyl/Tape Converter ha svart att urskilja skillnaden mellan ljud och tystnad. For att dela upp sparen manuellt,

avmarkera rutan markt "Automatically split recording into separate tracks" (Dela automatiskt upp inspelningen till separata spar)

eller "Split recording into tracks" (Dela upp inspelningen till spar). (Detta rekommenderas for typisk popularmusik, men kan

orsaka olika resultat nar det anvands med andra musikstilar, sdsom klassisk musik eller endast tal, etc.)

Nar du &r redo att borja spela in, klicka pa Record (Spela in) och spela omedelbart upp din musik genom att trycka pa "play"
(spela) och satt pickupnélen pa skivan, etc.).

STEG 3

Nu spelar du in. Du bér héra ljudet fran enheten genom datorns

hogtalare och se ljudmatarna réra sig. Om du inte hér musiken, se till att

dators volym inte &ar avstdngd. (Om du fortfarande inte kan hoéra

musiken, hanvisa till Felsdkningsavsnittet i denna manual.)

Om du véljer att manuellt dela upp sparen for din inspelning, kommer du

att se "New Track"-knappen (Nytt spar). Du kan anvanda denna knapp recording time:  00:00:25
for att markera borjan av ett nytt spar. recording track:  Automalic

Nar du har avslutat inspelningen, klicka pa Next (Nasta) for att fortsatta
till nasta steg.
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STEG 4

Nér du har avslutat inspelningen, fyll i Artist, Album och Track titles

(Lattitlar) genom att klicka i och skriva informationen i det X
korresponderande faltet. (Om du spelar in latar fran olika artister
och album, maste du spela in dem i separata omgangar.) el
Obs: Om du har spelat in mer dn 10 latar, kan du fa atkomst till (i
informationen for latarna 11-20 genom att klicka pa Next (Nésta). .
Nar du har fyllt i informationen foér din inspelning, klicka pa Next B e
(Néasta).
»
Programvaran exporterar nu din inspelning till iTunes. Se till att 7
vanta tills exporteringsprocessen har avslutats. X
STEG 5
Nar programvaran har exporterat dina inspelningar till iTunes, ser %
du skérmen till héger.
Valj Yes (Ja) om du vill spela in igen.
Valj No (Nej) om du inte vill spela in mer.
Né&r du har gjort ditt val, klicka pa Next (Nasta) for att fortsatta
spela in eller for att stinga programmet.
»

STEG 6
Nu kan du fa atkomst till dina_ inspelningar Fie m, mrc‘amiz Store Advanced Help. |Tu:|es [ST=T)
genom ditt iTunes-bibliotek. Andra till ditt V2@ —e % L3 =)
iTunes-fonster (iTunes Oppnas automatiskt |t ki Tie R o=

Unes ) A AT 247 mistor Aot
néar dina latar har exporterats.) Klicka pa ] o v Tz a6 anstez bz
Music-fliken till vénster och navigera till | o™ o T et
Artist, Album och Track titles (Lattitlar) som | oty T e
du fylide i for din inspelning. " veatn o oo prvkid
Fér att se de nyaste latarna som du la till i | s e e
ditt iTunes-bibliotek, klicka pa View-menyn |,
(Visa) och vélj As List (Som lista) och e
hogerklicka (eller "ctrl" + klicka for Mac) pa SIS
Namn-kategorin ovanfér latlistan. | menyn | %o
som visas, markera Date Added (Datum bl
tillagt) och klicka pa OK. Ovanfor latlistan, Dlspele
klicka pa kategorin Date Added. Din nyaste 3 e ot
|&t kommer att finnas 6verst pa listan. (Du e
kan klicka pa kategorin — Namn, Artist,
Datum tillagt, etc. — nar som helst for att
andra latordningen som visas i ditt iTunes- _ >
bibliotek.) + % 2 & 10 songs, 27.8 minutes, 4.6 ME =2

Fran iTunes kan du dven branna dina inspelningar direkt pa en CD eller hamta ner dem pa din iPod.

Hanvisa till iTunes Help menu (Hjalpmeny) fér mer information om hur man anvander iTunes.

Observera, att efter att du har éverfért musiken till din dator, kanske du méste vilja din dators ljudkort igen
som éateruppspelningsenhet. Annars kanske du inte hér ngot ljud nér du spelar upp musiken pa datorn. Fér

mer information, hdnvisa till Fels6kningsavsnittet.
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PROBLEM

Jag hor inget ljud nar jag spelar in
och ljudmétarna ror sig inte.

(0]3157:1.¢

USB-enheten &r inte paslagen.

OSNING

Om din enhet har en AV- och PA-knapp, se till att USB-enheten ar
paslagen.

USB-enheten &r inte ansluten till
datorn.

Se till att USB-enheten &r ansluten till en fungerande USB-port i datorn.
Om den redan &r ansluten, forsok att ateransluta den och starta om
programvaran.

USB-kabeln eller USB-porten
kan vara skadad.

Anvand en annan USB-kabel. Anslut &ven USB-enheten till en annan
USB-port i datorn.

Musiken spelas och jag ser att
lijudmatarna rér sig, men jag hor
inget ljud.

Ljudutgangen ar felaktigt
konfigurerad.

Se till att datorns ljudkort har valts som uppspelningsenhet.

Windows XP: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) (eller Settings (Instéllningar) » Control Panel in Classic
View (Kontrollpanel i klassisk vy)) » Sound and Audio Devices (Ljud
och ljudenheter). Klicka pa fliken Audio (Ljud) och under Sound
playback (Ljuduppspelning), valj din dators ljudkort som
standardenhet.

Windows Vista: Klicka pa Start Menu (Startmeny) > Control Panel
(Kontrollpanel) (eller Settings (Instéllningar) » Control Panel in Classic
View (Kontrollpanel i klassisk vy)) » Hardware and Sound (Hardvara
och ljud) » Sound (Ljud). Klicka pa fliken Playback (Uppspelning) och
vélj din dators ljudkort som standardenhet.

Windows 7: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) » Sound (Ljud). Klicka pé fliken Playback
(Uppspelning) och valj din dators ljudkort som standardenhet.

Mac: Klicka pa "apple"-ikonen i det dvre vénstra horet och klicka
sedan pa System Preferences (Systempreferenser) » Sound (Ljud).
Klicka pa fliken Output (Utgang). Fran menyn, valj Internal Speakers
(Interna hogtalare), om du anvénder datorns interna hogtalare eller vélj
Headphones (Hérlurar) om du anvénder hogtalare eller horlurar som
ar anslutna till dators 1/8"-hérlursutgang.

Datorns hégtalare &r avstangda.

H&j volymen fér dators hogtalare.

Datorns hogtalare ar inte
anslutna.

Om du anvander externa hogtalare, se till att de ar anslutna till datorns
ljudkort.

Ljudkvaliteten &r dalig.

Pickupanslutningen sitter 16st.

Om du anvéander en skivspelare med USB, sa maste pickupen vara
ordentligt ansluten pa tonarmen nar du anvénder skivspelaren.

Vinylskivan ar smutsig eller
repad.

Om du dverfér musik fran en vinylskiva, damma av den genom att
forsiktigt torka av ytan innan du spelar den.

Andra mjukvaruprogram stér EZ
Vinyl/Tape Converter.

Stang alla program, starta om datorn och kér endast EZ Vinyl/Tape
Converter under inspelning.

Pickupnalen kanske &r sliten.

Endast for skivspelare: Om pickupnalen &r aldre an ett ar eller har
anvants mycket, s kan nalen vara trasig eller sliten. Kontakta ION:s
avdelning for ljuddelar for att képa en ny pickupnal.

Inspelningsljudet later hogt och
férvrangt.

Forstarkarnivan ar for hog (gain).

Inspelningen ar knappt hérbar.

Forstarkarnivan ar for lag.

Om din USB-enhet &r utrustad med en "forstéarkar'-kontroll (gain),
justera den till en Iamplig niva. Du kan &ven justera ljudet med
forstarkarreglaget i programvaran bredvid volymnivamataren (den del
av laten med den hogsta volymen bor na den orangefargade delen pa
métaren).

De flesta operativsystem tillhandahaller ett nivareglage for
inspelningsvolymen som du kan justera:

Windows XP: (ej tillgangligt)

Windows Vista: Klicka pa Start Menu (Startmeny) > Control Panel
(Kontrollpanel) (eller Settings (Instéllningar) » Control Panel in Classic
View (Kontrollpanel i klassisk vy)) » Hardware and Sound (Hardvara
och ljud)» Sound (Ljud). Klicka pa fliken Recording (Inspelning) och
vélj "USB Audio Codec" (USB-ljudcodec) som standardenhet. Klicka
pa Properties (Egenskaper). | det nya fonstret, klicka pa fliken Levels
(Nivaer) och justera Mikrofon-reglaget till lamplig niva. Vi
rekommenderat att nivan stalls in pa "4".

Windows 7: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) » Sound (Ljud). Klicka pa fliken Recording
(Inspelning) och valj "USB Audio Codec" (USB-ljudcodec) som
standardenhet. Klicka pa Properties (Egenskaper). | det nya fonstret,
klicka pé fliken Levels (Nivaer) och justera Mikrofon-reglaget till
lamplig niva. Vi rekommenderat att nivan stalls in pa "4".

Mac: Klicka pa "apple’-ikonen i det 6vre vanstra homet och klicka
sedan pa System Preferences (Systempreferenser) » Sound (Ljud).
Klicka pa fliken Input (Ingang). Fran menyn, valj din USB-
inspelningsenhet och justera reglaget for Input Volume
(Ingangsvolymen) till [amplig niva.
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PROBLEM

Jag kan inte héra mina
inspelningar néar jag har 6verfort
dem och forsoker spela dem pa
datorn.

USB-enheten ar ansluten, men
jag kan inte héra nagon musik pa
datorn.

ORSAK

Datorns ljudutgang ar felaktigt
instélld.

Se till att dators ljudkort &r valt som din uppspelningsenhet.

Windows XP: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) (eller Settings (Installningar) » Control Panel in Classic
View (Kontrollpanel i klassisk vy)) » Sound and Audio Devices (Ljud
och ljudenheter). Klicka pa fliken Audio (Ljud) och under Sound
playback (Ljuduppspelning), valj dators ljudkort som standardenhet.
Windows Vista: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) (eller Settings (Instéllningar) » Control Panel in Classic
View (Kontrollpanel i klassisk vy)) » Hardware and Sound (Hardvara
och ljud)» Sound (Ljud). Klicka pa fliken Playback (Uppspelning) och
vélj dators ljudkort som standardenhet.

Windows 7: Klicka pa Start Menu (Startmeny) » Control Panel
(Kontrollpanel) » Sound (Ljud). Klicka pa fliken Playback
(Uppspelning) och valj datorns ljudkort som standardenhet.

Mac: Klicka pa "apple"-ikonen i det 6vre vanstra hornet och klicka
sedan pa System P (Systemp ) » Sound (Ljud).
Klicka pa fliken Output (Utgang). Fran menyn, valj Internal Speakers
(Interna hégtalare), om du anvéander datorns interna hogtalare och
sedan Line Output (Linjeutgang) om du anvander hogtalare, eller valj
Headphones (Horlurar), om du anvéander hérlurar anslutna till 1/8"-
utgéngen.

Mina inspelningar ar i mono
istéllet for i stereo pa Windows
Vista och Windows 7.

Egenskaperna fér
inspelningsingangen &r inte
instéllda pa "stereo".

Du kanske maste specificera "stereo" for inspelningsingangen
manuellt.

Ga till Start » Control Panel (Kontrollpanel) » Sound (Ljud) (i
klassisk vy). Klicka sedan pa fliken Recording (Inspelning) och
markera Mikrofon-ingangen (USB-ljudcodec). Klicka pa Properties
(Egenskaper) for att visa ingangsinstéliningarna. Klicka sedan pé fliken
Advanced (Avancerad) och vélj "2 channel, 16 bit, 44100 Hz (CD
quality)" (2 kanaler, 16 bitar, 44100 Hz (CD-kvalitet) i rullgardinsmenyn
Default Format (Standardformat). Klicka sedan pa Apply (Verkstall)
fér att acceptera installningarna.

Efter att jag har spelat in en fil pa
min Mac, visas den som "EZACT
Temp" i iTunes och spelas inte
upp.

iTunes-instéllningarmna maste
justeras.

| iTunes, klicka pa iTunes-menyn i det Gvre vanstra hornet och klicka
pa Preferences (Preferenser). Klicka pa fliken General (Allmént) och
sedan pa knappen Import Settings (Importera instéliningar) och stall
in Import Using (Importera med) till MP3 Encoder (Mp3-avkodare).
Klicka sedan pa fliken Playback (Uppspelning) och avmarkera Sound
Check (Ljudkontroll), Sound Enhancer (Ljudférbéttring) och

Crossfade Songs (Overtona mellan latar). Stang fonstret nar du ar
klar.

Endast for skivspelare: Om din USB-enhet har ett linje/phonoreglage
pa den bakre panelen, se till att det ar installt pa ratt niva for
ingangarna som det ar ansluten till ("line" (linje) eller "phono"). Om din
USB-enhet inte har nagot s&dant reglage, hanivsa till
Snabbstartsguiden som medfélide produkten, for att faststélla om det
ar ett linje- eller phono-reglage.

Obs: Du bedver inte ansluta din USB-enhet till ett hégtalarsystem, en
mottagare, etc. for att EZ Vinyl/Tape Converter ska kunna konvertera
din musik. Du behéver bara ansluta den till din dator (med en USB-
kabel).

LMANNA FRAGOR OCH SVAR

Fraga: Vilka operativsystem ar EZ Vinyl/Tape Converter kompatibel med?
Svar: EZ Vinyl/Tape Converter ar for narvarande kompatibel med operativsystemen Windows XP, Vista och 7 (32-bitars eller
64-bitars, samt med operativsystemet Mac OS X 10.4.11 (eller hogre).

Ljudet fran min USB-enhets
ljudutgangar later forvridet eller
statiskt.

Linje/phononiva-reglaget kanske
ar felaktigt installt.

Fraga: Till vilket digitalt format konverteras mina inspelningar till?

Svar: Inspelningarna konverteras till MP3-filer och till det bitvarde som valts i Import Settings (Impotera instéliningar) i iTunes.
For att visa/andra dessa instéllningar i iTunes, klicka pa menyn Edit (Redigera) och vélj Preferences (Preferenser) och valj
sedan fliken General (Allmant) och klicka pa knappen Import Settings (Importera instéliningar). Klicka pa rullgardinsmenyn
Import Using (Importera med) och vélj MP3 Encoder (MP3-avkodare). Nu kan du vélja onskat antal bitar under
rullgardingsmenyn Setting (Instéllning).

Fraga: Vart lagras mina inspelningar pa datorn?

Svar: Dina inspelningar lagras i iTunes musikmapp (Music folder). Som standard finns denna mapp i My Documents (Mina
dokument) » My Music P iTunes » iTunes Music p4 Windows OS, eller i Music P> iTunes P> iTunes Music p4 Mac OS
och innehallet &r organiserat efter Artist.

Fraga: Hur branner jag mina inspelningar pa en CD?

Svar: Det finns olika s&tt som du kan branna dina inspelningar pa en CD pa. Du kan antingen anvanda iTunes eller ett annat
CD-brannarprogram. Foér att branna en CD med iTunes, skapa en ny Playlist (Spellista) och dra latarna fran ditt vanliga
bibliotek till denna spellista. Nar du har lagt till de latar som du vill ha, klicka pa spellistan och pa knappen Burn Disc (Brann
CD). Hanvisa till iTunes hjalpmeny (eller ditt alternativa program) fér mer information.

Fraga: Kan jag lyssna pa musiken pa min dator nar jag spelar in?

Svar: Ja. EZ Vinyl/Tape Converter spelar automatiskt upp inkommande ljud genom din dator nér musiken &éverférs. Om du
anvander flera ljudenheter, rekommenderar vi att du avaktiverar de enheter som du inte vill anvdnda som monitorer. Fér de
flesta anvéndare &r detta inte nagot problem.
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